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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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SECTION 1 
GENERAL DESCRIPTION 

________________________________________________________________________________ 
1.1 FEATURES 
 
• Allows detection and rejection of leakers at speeds in excess of 2400CPM. 
 
• Performs the following control functions: 
 

1) Detection of leakers (pin holes, split flanges, gross leakers, etc.). Does not reject good cans 
following a gross leaker or missing can. 

 
2) Auto photo multiplier tube (PMT) calibrate feature which continuously calibrates the PMT offset with 

machine running in normal operation. 
 
3) Static PMT gain calibration feature allows operator to calibrate the gain of the PMT at the push of a 

button using a calibrated leak can with the machine not running. 
 
4) Controls Odd and Even reject solenoids to reject cans at speeds greater than 2400CPM using the 

existing solenoids. 
 
5) Detects the following alarm conditions: Bad Pocket (excessive rejects from pocket), excessive good 

can rejection (light seals of machine compromised), timing signal failure, and PMT calibrate error. 
 
6) Data collection built-in including: total number of cans rejected count, number of cans rejected per 

pocket, and total number of good cans processed. (For both current shift and last shift). 
 
• Halogen light source replaces both the existing fluorescent lamps and high frequency lamp 

driver for both increased test lumens and reliability. 
 
• Optional Data/Set-up display (2 line X 40 character display with 24 key membrane keypad) 

allows local viewing of collected data (can count, total rejects, rejects per pocket) by the 
operator and set-up of all user variables (key switch enabled) by authorized personnel. 

 
• Set-up and monitoring performed using “HSLRT6”, an easy to use menu driven software 

package which runs on any IBM PC or compatible. 
 
• Provided with resolver for machine mounting (replaces existing encoder) and built in 

programmable limit switch (PLS) with auto zero feature to simplify machine timing. 
 
• Based on high performance M4530 PLC/PLS/PMT module which allows easy trouble-shooting 

and user customization using SYSdev (DOS-based) programming package. 
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SECTION 1 
GENERAL DESCRIPTION 

________________________________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSL-RT6-M45 light tester package interfaces directly with the machine mounted photo 
multiplier tube (referred to hereafter as the PMT), machine mounted resolver, and the odd and even 
reject solenoids. The HSL-RT6-M45 detects defective cans (leakers), via the PMT, and rejects these 
cans by activating the respective odd or even reject solenoid at speeds up to 2400CPM. The photo 
multiplier tube (PMT) outputs a low level, high frequency analog value, which is proportional to the 
amount of light entering the tube. This output is input directly to the M4530 module and 
conditioned as necessary by the module to deduce the actual amount of 
 
light the tube detected. The tube is extremely sensitive and easily capable of detecting a hole of .002 
or less diameter in a can. The gain of the tube is adjustable by adjusting the voltage applied to the 
tube (0-1200 volts). The light tester package contains a 0 to 2000 volt variable power supply which 
supplies this voltage for the tube. 
 
Two timing signals, provided by the PLS and machine mounted resolver, are used to generate the 
PMT sample timing and reject timing. These signals are a Marker pulse, generated once per 12 cans 
and used to specify pocket #1, and a Sync pulse, generated once per pocket and used for the PMT 
sample and reject timing. The PMT tube is gated “on” at both the leading and trailing edges of the 
sync pulse. The leading edge gate pulse is used to actually sample the can for leaks and occurs 
when the tube is aligned with the pocket. The trailing edge gate pulse occurs between pockets at the 
dark portion of the shutter. This is used as a base “dark” measurement for offset calibration.  
 
Note: The tube is only gated “on” at these leading and trailing edge transitions for less than one 
millisecond and not just enabled continuously. This prevents the tube from saturating when a gross 
leaker or missing can is present at the pocket, allowing the following cans to be fully tested and not 
just rejected while the tube recovers from saturation. 
 
Two parameters, set in the M4530 module, are used to calibrate the tube. They are: the PMT gain 
and PMT input offset. The PMT gain is a 0 to 6 volt analog output on the M4530 which is feed into 
the 0 to 2000 volt power supply which supplies power to the tube. This parameter is used to set the 
gain of the tube such that the desired minimum leak will be rejected. Adjusting this output between 
0 and 6 volts adjusts the voltage applied to the PMT between 0 and 1200 volts, where 0 volts would 
result in no light detected (zero gain) and 1200 volts would result in the maximum sensitivity 
(maximum gain). The M4530 provides both manual and automatic modes of adjustment for the 
PMT gain (see sections 3.3 and 3.5). 
 
The PMT input offset parameter is an internal M4530 adjustment, which adjusts the offset of the 
PMT output at the input to the M4530. This adjustment is used to set the proper balance between 
the PMT value of good cans and the PMT value of bad cans such that the good cans are not rejected 
while the bad (leak) cans are (this essentially gets the PMT value into the proper range). The 
M4530 provides both manual and automatic modes of adjustment for the offset (see sections 3.1 
and 3.2). 
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SECTION 1 
GENERAL DESCRIPTION 

In general, optimum performance is achieved when both automatic offset and gain adjustment is 
selected. The automatic offset adjustment allows the M4530 to compensate for PMT drift due to 
temperature, etc. continuously while the machine is running. The automatic gain or calibration 
mode provides the simplest method of calibrating the PMT gain, allowing the operator to calibrate 
the PMT using just a calibrated leak can and no other special equipment. 
 
 
________________________________________________________________________________ 
1.3 ALARM DETECTION 
 
The package detects the following alarms: 
 
BAD POCKET: If any pocket rejects more than a 4 cans per 10 revolutions of the tester, this alarm 
is generated for that pocket. This indicates that either the light seal for the respective pocket is bad, 
or that some other mechanical problem relating to that pocket is occurring. 
 
EXCESSIVE GOOD CAN REJECTION: If ten consecutive cans are rejected, this alarm is 
generated. Once ten consecutive good cans are detected, the alarm is cleared. This generally 
indicates that a major light leakage has occurred either between the PMT shoe (gimbal) and the 
shutter wheel or in the pocket seals. This output can be used by the existing control system to stop 
the machine, preventing the rejection of excessive good cans. 
 
TIMING SIGNAL FAILURE DETECTION: The timing signal fail occurs when any of the timing 
signals generated in the PLS section fail to change state periodically while the machine is running. 
 
PMT CALIBRATE ERROR: If the M4530 is unable to calibrate the gain of the tube when a static 
calibration is performed, this alarm is set. This occurs either when the PMT does not detect enough 
light and the gain is maximized, or when the PMT detects too much light and the gain is minimized. 
In addition, this alarm occurs if the automatic offset adjustment routine adjusts the offset to the 
maximum or minimum offset but still cannot compensate for the offset of the PMT. 
 
The above alarms can be mapped to discrete outputs on the M4530 to interface with the existing 
system if desired. 
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SECTION 1 
GENERAL DESCRIPTION 

________________________________________________________________________________ 
1.4 DATA COLLECTION 
 
The following data is collected for both the current shift and the previous (last) shift: 
 

1) Total number of good cans tested 
2) Total number of rejected cans 
3) Total number of rejected cans for each pocket 

 
This data can either be viewed locally on the display by the operator, viewed through the 
“HSLRT6” set-up program, or can be sent to the host PLC via RS-232 communications (MODBUS 
or Allen-Bradley DF1 protocols) using the optional S4516 communications board. This information 
is updated (“current” shift transferred to “Last” shift) based on the change of state of a discrete 
input. This input can be activated on an 8 or 12 hour shift basis or alternatively could be activated 
manually on a label run basis depending on the user's preference. 
 
In addition to the shift data collection, a separate buffer is available to collect rejected cans per 
pocket counts as a diagnostics aid to the operator for trouble-shooting a bad seal problem for a 
specific pocket. Unlike the shift data, these counts can be reset manually by the operator at will. 
This allows the operator to note an abnormally high count on a specific pocket, attempt to correct 
the problem, reset the counts and then check the counts at a latter time to determine if the problem 
is corrected. This data is viewed on the HSL-RT6-DSP display. 
 
 
________________________________________________________________________________ 
1.5 HALOGEN LIGHT SOURCE 
 
The HSL-RT6-M45 package is provided with a halogen light source which replaces the existing 
fluorescent lamps and high frequency lamp driver. This provides light in the spectrum the PMT is 
optimized for but provides a number of additional benefits as well including: 
 
1) Increased test lumens which allows for a greater degree of system sensitivity. 
 
2) Elimination of the high frequency lamp driver and the failures associated with the driver. The 

halogen lamps are powered directly from 120VAC, 50/60HZ for the ultimate in lamp source 
simplification and reliability. 

 
3) Reduction of light emitted in the UV spectrum (as compared to the use of black light 

fluorescent) for increased personnel safety. 
 
The halogen light source is mounted on the existing lamp hood once the existing fluorescent lamps, 
ballast, and hood cover are removed. 
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SECTION 1 
GENERAL DESCRIPTION 

________________________________________________________________________________ 
1.6 LED STATUS INDICATIONS 
 
The following 4 status LEDs are located directly above the “CAL” port on the M4530: 
 
PWR: “On” when +24VDC power is applied to the PMT section of the M4530 (this +24VDC also 
supplies power to the 2000 volt power supply of the PMT). 
 
CAL: “On” after the calibrate procedure has been performed and the M4530 was able to calibrate 
the PMT gain successfully. “Off” if the PMT gain was not successfully calibrated. “Flashing” while 
the calibrate procedure is in process. See section 3.3 for details on the calibrate procedure. 
 
MAINT: “On” when an offset error has occurred. See section 7.2 for details. 
 
REJ: “On” when a leaker can is detected by the PMT. “Off” when a good can is detected by the 
PMT. 
 
The following 3 status LEDs are located directly above the “PROG” port on the M4530: 
 
PWR: “On” when +5VDC power is supplied from the P4500 power supply to the M4530. 
 
RUN: “On” steady when the M4530 PLC section is running a valid user's program. “Off” when an 
internal fault is detected or when a valid user's program has not been loaded. The RUN LED will 
flash during program download as well. 
 
FLT: “On” when an internally detected fault has occurred in the M4530 PLC section. See section 
7.3 for details. 
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GENERAL DESCRIPTION 
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SECTION 2 
INSTALLATION 

The standard HSL-RT6-M45 package is provided in a NEMA 12 enclosure for mounting on the 
machine directly. 
 
 
________________________________________________________________________________ 
2.1 WHAT'S INCLUDED 
 
Verify that the following items are included when unpacking the HSL-RT6-M45: 
 
 
________________________________________________________________________________ 
2.1.1 HSL-RT6-M45 (STANDARD PACKAGE) 
 

1ea. HSL-RT6-M45 NEMA 12 enclosure including the following: 
1ea. M4530 PLC/PLS/PMT module 
1ea. P4500 Power Supply 
1ea. PS2000N1 High Voltage (2000 volts) Power Supply 

 
1ea. 9956B-16 Photo Multiplier Tube 
1ea. B2F-RFI PMT Housing (with A1H PMT Preamp and GB1BH PMT Gating Circuit) 
1ea. PMT Mounting bracket set (15-002-1 and 15-002-2) 
1ea. PMT Cable Set (2ea. BNC Cables-4ft., 1ea. Lemo Cable-4ft) 
 
1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-20 Resolver Cable 
 
1ea. Halogen Light Source Assembly 
 
1ea. HSL-RT6-M45 User's Manual 
1ea. M4530 User's Manual 
1ea. HSL-RT6-M45 Program Disk 

 
 
________________________________________________________________________________ 
2.1.2 HSL-RT6-M45 OPTIONS (PURCHASED SEPARATELY) 
 
The following items can be purchased separately as required or desired: 
 

1ea. S4516 Data Communications Board (MODBUS and DF1 protocols) 
 
1ea. HSL-RT6-DSP Data/Set-up Display (D4591 2 Line X 40 character display with 24 key keypad 

mounted in a NEMA 12 mini-pedestal for direct mounting to the HSL-RT6-M45 enclosure). 
 
1ea. S4573 16-Point 10-30VDC Output to drive individual pocket reject indicators. 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.2 POWER REQUIRED 
 
The HSL-RT6-M45 is powered from 115VAC, 50/60HZ and +24VDC. The 115VAC is used to 
power the M4530 module and the Halogen Light source while the +24VDC is used to power the 
PMT section, 2000 volt power supply, and +24VDC I/O (odd/even reject solenoids, etc.). The 
+24VDC current required by the HSL-RT6-M45 is approximately only 1.0 AMP more than the 
existing system's +24VDC current requirement, therefore the existing +24VDC power supply 
should be adequate.  
 
Note: The +24VDC must be regulated (+/-10%). 
 
 
________________________________________________________________________________ 
2.3 MOUNTING THE HSL-RT6-M45 ENCLOSURE 
 
The HSL-RT6-M45 enclosure should be mounted in the location that the high frequency lamp 
driver box was located. This is directly below the PMT location on the machine. To install the 
enclosure, first remove the wiring associated with the high frequency lamp driver and then remove 
the high frequency lamp driver box. Mount the HSL-RT6-M45 in the location the high frequency 
lamp driver box was mounted as conveniently close to the PMT as possible. 
 
 
________________________________________________________________________________ 
2.4 MOUNTING THE RSV34-MS1 RESOLVER 
 
The HSL-RT6-M45 is designed to interface to a resolver (not encoder) for machine timing. To 
mount the resolver, perform the following: 
 
1) Remove the existing encoder. 
 
2) Mount the resolver in place of the encoder making sure the resolver shaft does not bind when 

the machine is rotated. Refer to the RSV34-MS1 data sheet for details on mounting the resolver. 
 
3) Connect the supplied RSV-RSCBLE-20 cable to the MS connector on the resolver. Route the 

resolver cable in a separate conduit, away from all other high voltage (motor leads) and control 
wiring. Wire the cable directly to the 8-pin resolver connector on the M4530 (see section 2.7). 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.5 MOUNTING THE PMT HOUSING 
 
The HSL-RT6-M45 PMT replaces the entire existing Reynolds PMT assembly (with the exception 
of the shutter gimbal which is used) and is actually mounted in the same location. To mount the 
PMT, perform the following: 
 
1) Remove the existing Reynolds PMT assembly. 
 
2) Mount the supplied 15-002-2 PMT collet to the 15-002-1 mounting plate as shown in figure 1 

on the drawing at the back of this manual, if not already done. 
 
3) Carefully slide the 15-002 assembly over the PMT housing from the rear as shown in figure 1 

and slide up until seated against the front lip of the PMT housing. Tighten the collet set screws 
against the PMT to hold the PMT in the collet. 

 
4) Mount the entire PMT assembly to the machine frame, using the existing PMT mounting holes. 

When mounting the assembly, make sure the front of the PMT assembly is seated and sealed in 
the existing shutter gimbal. 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.6 INSTALLING THE PMT TUBE INSIDE THE PMT HOUSING 
 
These instructions are used to install the tube in the housing both at the initial installation of the 
HSL-RT6-M45 and when it is necessary to replace the tube. The 9956B-16 tube is installed inside 
the B2F-RFI housing once the housing is installed on the machine as follows: 
 
IMPORTANT: For your safety, power to the PMT housing must be “off” prior to removing the 

Preamp/Gating Circuit assembly from the B2F-RFI housing. The Preamp/Gating Circuit and 
PMT are supplied with as much as 2000 volts DC. This power must be removed before any part 
of the B2F-RFI housing seal is broken. The housing is powered from the PS2000N1 which is 
powered from the +24VDC power supply. Therefore disconnecting the +24VDC power supply 
will power down the PS2000 power supply. 

 
1) Disconnect the +24VDC power supply which powers the PMT section and PS2000N1 high 

voltage power supply. 
 
2) Remove the Preamp/Gating circuit assembly from the B2F-RFI housing by unscrewing the 

connector plate from the housing and then removing the Preamp/Gating assembly. The 
Preamp/Gating assembly is attached to the connector plate and is removed from the housing 
with the plate. 

 
3) Carefully install the 9956B-16 tube in the Preamp assembly connector. The tube is keyed (by a 

missing pin in the tube) and should fit in the Preamp connector only one way. 
 
4) Carefully install the Tube/Preamp/Gating assembly back in the housing making sure the tube 

seats in the nose of the housing correctly and then screw the connector plate into the housing. 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.7 WIRING THE HSL-RT6-M45 
 
Perform the following to wire the HSL-RT6-M45: 
 
1) Wire the odd/even reject solenoids and machine interlocks (main drive “on”, sync timing 

output, leaker reject output, etc.) to the existing control system, referring to the electrical control 
schematic at the back of this manual, keeping all +24VDC wiring away from high voltage 
(motor leads) wiring. 

 
2) Wire the machine mounted resolver directly to the 8-pin resolver input connector on the M4530 

module using the supplied RSV-RSCBLE three pair, two conductor shielded cable. The shield 
of the resolver cable should be tied to SHLD terminal of the M4530 resolver input connector. 
Make sure the resolver cable shield is left floating at the resolver. Refer to the electrical control 
schematic at the back of this manual for details. 

 
3) Wire +24VDC power from the user supplied +24VDC power supply to FU3 and wire #500 as 

shown. 
 
4) Wire 115VAC, 50/60HZ power to fuses FU1 and FU2 as shown. 
 
5) Connect the BNC cable marked “GATE” to the “GATE” connector on the B2F-RFI housing 

and then to the “GATE” connector on the side of the HSL-RT6-M45 enclosure. This signal 
“gates” the PMT “on” (applies the high voltage to the PMT) when the sample is taken. 

 
6) Connect the BNC cable marked “SIG” to the “SIG” connector on the B2F-RFI housing and then 

to the “SIGNAL” connector on the side of the HSL-RT6-M45 enclosure. This is the output of 
the preamp from the PMT. 

 
7) Connect the MHV connector on the end of the PS2000N1 cable to the “HV” connector on the 

B2F-RFI housing. 
 
8) Connect the Lemo cable to the corresponding connectors on the B2F-RFI housing and the side 

of the HSL-RT6-M45 enclosure. This supplies +/-12VDC to the Preamp/Gating circuits of the 
B2F-RFI housing. 

 
9) Keep the coax cables mounted in steps (5) through (8) above away from all other wiring. These 

signals are low level signals and should not be mixed with any other wiring. 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.8 MOUNTING THE HALOGEN LIGHT SOURCE 
 
The HSL-RT6-M45 package is provided with a halogen light source which replaces the existing 
fluorescent lamps and high frequency lamp driver. Mount the halogen light source assembly as 
follows: 
 
1) Remove the cover from the existing fluorescent lamp hood. 
 
2) Remove the existing fluorescent lamps, ballast, lamp brackets, and wiring (essentially “gut” the 

existing lamp hood). 
 
3) The existing curved plexi-glass cover (mounted on the hood between the star wheel and hood) is 

retained. This prevents grease from being slung onto the halogen lamp glass covers. Clean the 
inside of the curved plexi-glass cover before mounting the halogen lamp assembly. 

 
4) Mount the halogen light source assembly on top of the hood in the same fashion that the hood 

cover was mounted (the halogen lamp assembly replaces the hood cover). 
 
5) Wire 115VAC power to the halogen lamps and fans of the assembly as shown in the schematic 

at the end of this manual. 
 
6) This is also a good time to make sure the plexi-glass light windows at the pocket seals are clean 

and free of contaminates. 
 
7) The hub of the starwheel is used as a reflector to illuminate the underside of the can to be tested. 

Verify that the hub is clean and well polished. 
 
Due to the high radiated heat levels of halogen lamps, the lamps are turned “off” after a time delay 
when the machine stops. This prevents the halogens from baking the can that stops at the light test 
pocket. Once the machine starts again, the lamps are turned “on” immediately. This is controlled by 
CR1 in the HSL-RT6-M45 enclosure. In addition, a buck transformer is used to reduce the voltage 
on the lamps to about 80% of nominal line voltage. This reduces the radiated heat from the lamps 
without significantly reducing the lumens produced. 
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SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.9 HALOGEN BULB REPLACEMENT 
 
Perform the following to replace either of the Halogen bulbs: 
 
1) Disconnect power to the light source assembly and let the lamps and lamp housing glass covers 

cool. 
 
2) Remove the lamp housing glass cover by removing the two wing nuts which secure the glass 

cover retainer with one hand and holding the glass cover with the other hand while the wing 
nuts are removed. Remove the glass cover from the assembly. 

 
3) With a clean rag, remove the Halogen bulb from the fixture. One contact of the fixture is spring 

loaded, the bulb is removed by compressing the spring loaded contact and then removing the 
bulb. 

 
4) Replace bulb with GE part number Q350T3/CL/HIR bulbs only. These are 350W, Halogen-IR 

lamps which produce approximately 50% more lumens per watt than ordinary Halogen lamps. 
 
5) Install new bulb again using a clean rag to hold the bulb while it is being installed. Do not 

handle the quartz envelope directly as fingermarks or any type of grease may cause 
devitrification of the quartz resulting in reduced performance and possible breakage or 
shattering. 

 
6) Once the bulb is re-installed, mount the glass cover back over the lamp housing, securing the 

cover with the retainer and wing nuts. Do not operate the light source assembly without the 
glass covers installed. The glass covers perform a number of functions including: preventing 
debris from being expelled inside the hood if the halogen lamp shatters, filtering the UV 
component of the light spectrum emitted from the lamp, and reflecting much of the heat 
generated from the halogen lamp out the top of the light source assembly instead of down into 
the machine. 
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________________________________________________________________________________ 
2.10 MOUNTING THE KEYPAD/DISPLAY (OPTIONAL) 
 
The D4591 HSL-RT6 Keypad/Display is mounted in a mini-pedestal which is mounted to the top of 
the HSL-RT6-M45 enclosure in the user's preferred location. To mount the display, perform the 
following: 
 
1) Determine the desired location on top of the HSL-RT6-M45 enclosure to mount the HSL-RT6-

DSP and punch a 2” hole at what will be the center of the pedestal. Drill 4ea. 9/32” holes around 
the 2” hole to match the pedestal mounting base. 

 
2) Mount the HSL-RT6-DSP pedestal to the top of the HSL-RT6-M45 enclosure using the 

supplied gasket, bolts, and nuts. 
 
3) Mount the Display enclosure to the top of the pedestal using the supplied gasket, bolts, and nuts. 
 
4) Install the supplied 26-pin ribbon cable to the connector on the back bottom of the D4591 

display (the cable connector is polarized and will only mate with the D4591 connector one 
way). Route the cable down the pedestal into the HSL-RT6-M45 enclosure. 

 
5) Remove the four screws retaining the M4530 module to the back-panel and install the 26-pin 

ribbon cable to the display connector on the back of the M4530 module (the cable connector is 
polarized and will only mate with the M4530 connector one way). Install the M4530 back on 
the back-panel. 

 
6) The HSL-RT6-DSP installation is now complete. Refer to section 4 for complete details on 

using the HSL-RT6 Keypad/Display. 
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________________________________________________________________________________ 
2.11 HSL-RT6-M45 SOFTWARE INSTALLATION 
 
Follow the steps below to install either the Windows or DOS based setup programs and PLC 
application program on a PC used to support the HSL-RT6-M45control system. 
 
 
________________________________________________________________________________ 
2.11.1 WINDOWS BASED SET-UP PROGRAM INSTALLATION 
 
The HSLRT6 setup program is compatible with Windows 95/98/ME/2000/XP operating systems 
and is used to: 
 1) Setup (tune) the user adjustable variables. 
 2) Adjust the timing channel set-points. 

3) Download the application program to the M4530 module. 
4) Download (restore) or upload (save) the user setup variables from the M4530. 
5) View “Rejects Per Pocket” and “Shift” data 

 
To install the set-up software, perform the following steps: 
 

1) Insert the HSLRT6 CD into the drive 
 

2) From the Windows desktop, “Click” Start and then select run. 
 

3) From the “Run” dialog box, “Click” the Browse button.   
 

4) Select the drive with HSLRT6 CD.  Select the “setup.exe” file and “Click” Open and then 
Ok. 

 
5) This will initiate the installation process.  Follow the instructions that appear on the screen 

to complete the installation process.  The HSLRT6 setup program can be executed from the 
“Systems” folder located in Programs from the Start menu. 
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________________________________________________________________________________ 
2.11.2 DOS BASED SET-UP PROGRAM INSTALLATION 
 
The HSLRT6 DOS based set-up software is used to:   

1) Setup (tune) the user adjustable variables. 
2) Adjust the timing channel set-points. 
3) Download the application program to the M4530 module. 
4) Download (restore) or upload (save) the user setup variables from the M4530 to disk. 
5) View “Shift” and “Rejects Per Pocket” data.  

 
To install the DOS based set-up software perform the following steps: 
 
1) Create a directory off the root directory of the PC for the HSL-RT6-M45 called “HSLRT6”. 

This will be used to store the “HSLRT6.EXE” setup program and HSLRT6 application 
program. Create this directory by typing the following at the DOS prompt: 

 
MD  \HSLRT6<ENTER> 

 
2) Install the disk labeled “HSL-RT6-M45 PROGRAMS” into the A: drive. Switch to the 

“HSLRT6” directory and install the “HSLRT6” set-up program by typing the following at the 
DOS prompt: 

 
CD  \HSLRT6<ENTER> 
A:INSTALL<ENTER> 

 
3) Add the HSLRT6 set-up program to your computer's menu software by creating a selection 

called “SET-UP HSL-RT6”. The DOS commands executed for this selection should be: 
 

For the “SET-UP HSL-RT6” selection: 
CD  \HSLRT6<ENTER> 
HSLRT6<ENTER> 
CD  \<ENTER> 

 
4) To execute the set-up program, simply select the “SET-UP HSL-RT6” selection from the menu 

software's menu. 
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________________________________________________________________________________ 
2.11.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE INSTALLATION 
 
The SYSdev Program Development software is used to perform on-line trouble-shooting and 
program modifications to the HSL-RT6-M45. If SYSdev was purchased with the HSL-RT6-M45 
package and is not already installed on the your computer, install SYSdev onto the hard drive of 
your computer following the steps of the SYSdev Program Development manual. 
 
 
________________________________________________________________________________ 
2.11.4 APPLICATION PROGRAM INSTALLATION 
 
The HSLRT6 application program is a SYSdev based program loaded into the M4530 module and 
performs the HSL-RT6-M45 logic. The HSLRT6 program is written in a combination of Ladder 
logic and High-level. If the user desires to make program changes or perform on-line monitoring of 
the program execution, the files which constitute the HSLRT6 program will have to be loaded onto 
the hard drive of the PC which is used to support the HSL-RT6. The SYSdev Program Development 
Software will also have to be loaded on the PC. To install this program perform the following: 
 
1) Install the disk labeled “HSL-RT6-M45 PROGRAMS” into the drive.  
 
2) For each of the “ HSLRT6” directories (created in section 2.11.2), copy all the files from the 

disk to each of these subdirectories. 
 
 
________________________________________________________________________________ 
2.12 TUNING THE HSL-RT6-M45 
 
The HSL-RT6-M45 is shipped from the factory with the PLC program “HSLRT6” loaded in the 
M4530 module (PLC section). This is the standard program used to implement the standard HSL-
RT6-M45 light tester algorithms.  
 
Once the HSL-RT6-M45 is installed and the control system is powered back up, perform the 
following to set-up and tune the HSL-RT6-M45. The set-up is performed using a PC running the 
“HSLRT6” set-up program or the optional Keypad/Display. See sections 5 or 6 for a description of 
the “HSLRT6” menus and variables and how to use the “HSLRT6” program. See section 4 for a 
description of the Keypad commands and menu displays of the HSL-RT6 Keypad/Display. 
 
At the initial installation, prior to performing the set-up steps below, verify that the default user 
variables (see section 2.12.1) are set to the values listed.  
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________________________________________________________________________________ 
2.12.1 DEFAULT SET-UP VARIABLES 
 
As shipped, the user variables of the PMT section of the M4530 are set to the following defaults: 
 

PMT Gain (PMT Voltage 0-1200V)  : 1101 
Gain Calibrate PMT Input Average  : XXX 
M4530 PMT Input Sensitivity  : 7 
PMT Input Offset (-75 to 75)  : 000 
PMT Reject Can Threshold  : 075 
Automatic Offset Mode: 
 Enabled (Y/N) : YES 
 Desired Good Can PMT Value  : 030 
 Allowed Good Can Error  : 002 
PMT Gain Calibration Mode: 
 Enabled (Y/N)  : YES 
 Desired Calibrated Leaker Reject PMT value  : 120 
 Allowed Calibrated Leaker Reject Error  : 005 

 
 
Where “XXX” of the “Gain Calibrate PMT Input Average” can be any number. This will change 
when a calibrate cycle is performed. 
 
 
________________________________________________________________________________ 
2.12.2 SET MACHINE ZERO 
 
Unlike the original encoder, the resolver shaft is not mechanically adjusted, to zero the timing, but 
instead is electronically adjusted in the PLS section. Position the machine with pocket #1 precisely 
aligned with the PMT, this is the machine zero location. Set the resolver offset per section 4.11 
(HSL-RT6 Keypad/Display).  Refer to section 5 (Windows based setup program reference) or 
section 6 (DOS based setup program reference) to set the resolver using the setup program. 
 
Note: The M4530 PLS is automatically programmed with the Sync timing (CH00) and Marker 
timing (CH01). No other PLS timing channel programming is required by the user. The Sync timing 
goes “on” at the centerline of PMT tube to pocket alignment and goes “off” at the centerline in 
between pockets. 
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________________________________________________________________________________ 
2.12.3 VERIFY THE B2F-RFI PMT HOUSING OFFSET 
 
The C634 A1H Preamp board inside the B2F/RFI housing contains an offset potentiometer, used to 
null any offset of both the PMT and amplifier circuitry. If this inherent offset of the PMT and 
amplifier is too great, this potentiometer may have to be adjusted to null the offset to zero. This is 
done by running cans through the machine and verifying the value the PMT offset automatically 
obtains. The PMT housing offset only needs to be set at the initial installation or any time the B2F-
RFI PMT housing is replaced. All other offset variations due to temperature, etc. are automatically 
compensated for with the automatic offset adjustment feature of the M4530. This adjustment simply 
makes sure the offset potentiometer of the PMT housing is not set outside the normal range of 
operation. Verify the offset as follows: 
 
1) Run the machine with cans at normal line speeds and verify that the offset is automatically 

adjusted until the “PMT Input Average” is equal to the “Desired Good Can PMT Value” within 
plus or minus 2. “Up Peak (Max)” and “Down Peak (Min)” should also be within plus or minus 
5 of the “PMT Input Average”. 

 
2) If the offset exceeds + or -250 in an attempt to set the “PMT Input Average” equal to the 

“Desired Good Can PMT Value”, the MAINT LED on the M4530 will be illuminated. This 
indicates that the PMT is detecting an excessive amount of light both when the cans are sampled 
and at the in-between pocket measurement. Verify that the machine is timed properly per 
section 2.12.2 and that no light leakage is occurring at any of the PMT seals (machine shutter to 
light seal plate, PMT to light seal plate, or at the PMT housing itself). 

 
3) If the offset is greater then +/-20, disconnect the +24VDC power that powers the PS2000N1 

high voltage power supply and remove the top of the B2F/RFI housing (side that contains 
connectors) and adjust the potentiometer on the A1H Preamp board (first board below 
connectors). Turning the pot clockwise will decrease the offset, turning it counter clockwise will 
increase the offset. One turn of the potentiometer changes the offset by about 40 to 50. 

 
4) Re-install the top of the B2F/RFI housing, power up the +24VDC power supply that powers the 

PMT section of the M4530 and the PS2000N1 power supply and perform step 1 again. Repeat 
steps 1 thru 3 until the offset is less than +/-20 while the machine is running with good cans. 
The closer the offset is to zero, the better. 

 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- 19 - 



SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.12.4 CALIBRATE THE PMT GAIN 
 
Stop the machine, install a calibrated leaker in the machine at the PMT and perform the gain 
calibration per section 3.4. If no calibration error occurred proceed to section 2.12.5. 
 
If a calibration error did occur (“CAL” LED on front of M4530 “off” at completion of the 
calibration procedure), observe the value of the PMT gain, either on the “M4530 Set-up” menu of 
the “HSLRT6” set-up program or the “View PMT Data” menu of the HSL-RT6 Keypad/Display 
and verify the following: 
 
1) If the “PMT Gain” is less than 500 volts and the “Gain Calibrate PMT Input Average” is greater 

than the “Desired Calibrated Leaker Reject PMT Value” by more than 5, the PMT detected too 
much light and was not able to reduce the gain of the PMT adequately to compensate for the 
amount of light detected. Verify that the calibrated leaker has a .0025 or less calibration hole in 
it and does not have any other areas of light leakage in the can. Verify that the seal at the pocket 
used for calibration is not leaking. Verify that no light leakage is occurring at any of the PMT 
seals (machine shutter to light seal plate, PMT to light seal plate, or at the PMT housing itself). 

 
2) If the “PMT Gain” is at 1101 volts and the “Gain Calibrate PMT Input Average” is less than the 

“Desired Good Can PMT Value” by more than 5, then the PMT did not detect enough light and 
was not able to increase the gain enough to calibrate the M4530. Verify that the calibrated 
leaker has a .0025 calibration hole in it and also verify that the light source is generating an 
adequate supply of light (lamps are “on” when calibration is performed). If so, set the “Desired 
Calibrated Leaker Reject PMT Value” to a lower value (it can be set as low as 10 above the 
“Desired Good Can PMT Value”) and try the calibration again. If the “Desired Calibrated 
Leaker Reject Value” is lowered, the “PMT Reject Can Threshold” should also be lowered (it 
should be between the “Desired Good Can PMT Value” and the “Desired Calibrated Leaker 
Reject Value”). 
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________________________________________________________________________________ 
2.12.5 VERIFY CALIBRATED LEAKER REJECTION 
 
Run the machine at normal production speeds and verify that calibrated leakers, when run through 
the machine, are rejected. Using the “HSLRT6” set-up program, observe both the Good Can Data 
and the Rejected Can Data. The “PMT Input Average” should be within plus or minus 2 of the 
“Desired Good Can PMT Value” set in the “M4530 Set-up Menu” (normally set to 30). The “Up 
Peak (Max)” and “Down Peak (Min)” should be within plus or minus 5 of the “PMT Input 
Average”. As leaker cans are rejected, they will appear in the “Last Reject Value” through “8th to 
Last Reject Value” stack. When the calibrated leakers are run through the machine, the reject values 
of these cans will also appear in this stack. 
 
If any of the calibrated leakers are not rejected when run through the machine, lower the “PMT 
Reject Can Threshold” and try again. This value can be lowered to within 5 above the “Desired 
Good Can PMT Value”. If some of the calibrated leakers still are not rejected, increase the “PMT 
Gain” (this can be increased to a maximum of 1200 volts) and try again.  
 
Note: Running the gain of the PMT above 1100 volts will shorten the life of the PMT. If some of 
the calibrated leakers are still not rejected, verify that the quality of light is adequate (both halogen 
lamps are “on” and hub of starwheel is polished). 
 
If the machine seems to be rejecting an excessive amount of cans, select the “4: View Can/Reject 
Counts” selection from the Main Menu of the “HSLRT6” set-up program or the “Rejects Per 
Pocket” selection of the HSL-RT6-DSP display and observe the Per Pocket Reject Totals. If a 
particular pocket is rejecting a significantly higher number of cans than the other pockets, then that 
pocket most likely has a bad light seal (or some other mechanical problem). In general, this menu 
can be used to evaluate the reject performance of the machine. 
 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- 21 - 



SECTION 2 
INSTALLATION 

________________________________________________________________________________ 
2.13 M4530/P4500/D4591 INSTALLATION 
 
The following is provided only as a reference. These steps are performed by the factory prior to 
shipping the HSL-RT6-M45. These steps need only be performed in the event either the M4530 
module, P4500 power supply, or D4591 display need to be replaced. Refer to the M4530 User's 
Manual for general details on installing the M4530, P4500, and D4591. 
 
 
________________________________________________________________________________ 
2.13.1 M4530 MODULE INSTALLATION 
 
To install the M4530 module, perform the following: 
 
1) Remove the cover from the M4530 chassis (retained with three captive screws on the lower 

front of the cover and two captive screws on each side of the M4530 chassis). 
 
2) Install S4568 (SLOT0-0): This is the basic input/output board (reject solenoids, etc.). Set the 

slot address dip switches (SW1) on the S4568 to the following positions (slot0): 
 

S4568:  SW1 switch1 = “OFF” 
SW1 switch2 = “OFF” 

 
Install the S4568 in Slot0-0 (furthest left slot) of the M4530 chassis. 

 
3) Install S4516 (SLOT0-1) (OPTIONAL): This is the optional communications (MODBUS or 

Allen-Bradley DF1) serial communications board. Set the slot address dip switches (SW2) on 
the S4516 to the following positions (slot1): 

 
S4516:  SW2 switch1 = “ON” 

SW2 switch2 = “OFF” 
 

Set the RS-232/RS-422 select dip switches (SW1) on the S4516 to the following positions (RS-
232 selected): 

 
S4516:  SW1 switch1 = “ON” 

SW1 switch2 = “OFF” 
 

Install the S4516 in Slot0-1 (slot next to S4568) of the M4530 chassis. 
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4) Install S4573 (SLOT0-2) (OPTIONAL): This is the optional pocket reject indicators output 
board. Set the slot address dip switches (SW1) on the S4573 to the following positions (slot2): 

 
S4573:  SW1 switch1 = “OFF” 

SW1 switch2 = “ON” 
 

Install the S4573 in Slot0-2 (slot next to S4516) of the M4530 chassis. 
 
5) Install the cover back over the M4530, making sure all the board connectors protrude through 

the slots in the cover. Tighten the three captive screws on the lower front of the cover and the 
two captive screws on each side of the M4530 chassis. 

 
6) Connect the display ribbon cable to the connector on the back of the M4530 (the connector on 

the cable is polarized and should mate with the connector on the M4530 in only one way). 
 
7) Mount the M4530 chassis to the HSL-RT6-M45 backpanel using four 8-32 screws. 
 
8) With power to the P4500 “off”, install the P4500 power supply cable to the +5/C/+12/C/-12 

connector on the M4530 (the connector on the cable is polarized and should mate with the 
connector on the M4530 only one way). 

 
9) Install the respective field wiring arms on all the I/O boards of the M4530 (I/O slots 0 and 2, 

RS-232 connector on USER PORT, resolver connector, and PMT section connector). Make sure 
all the field wiring connectors are fully mated in the M4530. 

 
10) Install the “GATE” and “SIG” coax cables to the respective BNC connectors of the M4530 

PMT section (upper BNC connector is “GATE”, lower BNC connector is “SIGNAL”). 
 
 
________________________________________________________________________________ 
2.13.2 P4500 POWER SUPPLY INSTALLATION 
 
To install the P4500, perform the following steps: 
 
1) Mount the P4500 to the HSL-RT6-M45 in the mounting holes next to the M4530 (left side) 

using two 8-32 screws. 
 
2) With power to the P4500 “off”, install the P4500 power supply cable to the +5/C/+12/C/-12 

connector on the M4530 (the connector on the cable is polarized and should mate with the 
connector on the M4530 only one way). 
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________________________________________________________________________________ 
2.13.3 D4591 KEYPAD/DISPLAY INSTALLATION 
 
To install the D4591 Keypad/Display, perform the following steps: 
 
1) With the gasket installed on the mounting studs of the D4591, install the D4591 in the cut-out in 

the HSL-RT6-M45 display enclosure. Secure the display to the enclosure using 7ea. 8-32 nuts 
and external lock washers. 

 
2) Connect the display ribbon cable to the connector on the lower back of the display (the 

connector on the cable is polarized and should mate with connector on the M4530 only one 
way). 

 
 
________________________________________________________________________________ 
2.13.4 DOWNLOAD “HSLRT6” PROGRAM TO M4530 
 
Once the M4530/P4500/D4591 are installed, perform the following to download the HSLRT6 
application program to the M4530: 
 
1) Power up the M4530 and the PC used to interface with the HSL-RT6-M45. 
 
2) Connect an RS-232 cable from the computer COM port to the “PROG” port on the M4530. 
 
3) Execute the “HSLRT6” set-up program. 
 
4) Download the HSLRT6 application program to the M4530 (refer to section 5.2.3 – Windows 

setup program reference or section 6.7 – DOS setup program reference) 
 
5) Set the resolver zero as outlined in section 2.12.2. 
 
6) Verify the PMT offset, calibrate the PMT Gain, and verify the calibrated leaker rejection as 

outlined in sections 2.12.3 thru 2.12.5. 
 
7) The M4530 is now ready to run. 
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The following sections describe the different offset and gain modes as well as the calibration 
procedure in detail. 
 
 
________________________________________________________________________________ 
3.1 AUTOMATIC OFFSET ADJUSTMENT 
 
Automatic PMT input offset mode is enabled by setting the “Automatic Offset Mode Enabled” to 
“YES” using the HSLRT6 set-up program. In addition, the user must set the value of the “Desired 
Good Can PMT value” as well as the “Allowed Good Can Error” (deviation) from the specified 
good can value. The “Desired Good Can PMT value” is typically set at 25 to 35. The “Allowed 
Good Can Error” (deviation) is typically set to 2 or 3. When the automatic offset feature is enabled, 
the M4530 averages the value of all good cans detected as well as the in-between pocket “dark” 
measurement over 36 consecutive pockets and automatically adjusts the PMT input offset until this 
average equals the “Desired Good Can PMT value” within the specified error (Allowed Good Can 
Error). This adjustment occurs continuously and compensates for any drift in the PMT due to 
temperature variations. 
 
 
________________________________________________________________________________ 
3.2 MANUAL OFFSET ADJUSTMENT 
 
Manual PMT input offset mode is enabled by setting the “Automatic Offset Mode Enabled” to 
“NO” using the HSLRT6 set-up program. In this case, the user enters the absolute value of the 
offset after the automatic offset is disabled. The offset is set to a number between -250 and +250. 
 
Perform the following to manually set the offset: 
 
1) Using the HSLRT6 set-up program view the M4530 PMT data and monitor the “Average PMT 

Input”. This is the average of all good cans and the in-between pocket “dark” measurement 
through 36 consecutive pockets. 

 
2) Using the HSLRT6 set-up program select “No” to the “Enable Automatic Offset Mode”. Then 

observe the “PMT Input” from the “View PMT Data” and adjust the “PMT Offset” as necessary 
until the “PMT Input” is between 25 and 30 (this assumes the reject threshold is set to 35 or 
above). This establishes the proper base value for good cans, such that bad (leaker) cans can be 
detected. 

 
3) If the PMT gain is subsequently manually adjusted (see section 3.5), the PMT offset will then 

again have to be adjusted and so forth until both values are set properly. 
 
Note: The automatic offset mode is strongly recommended for use over the manual offset mode. 
The automatic offset mode automatically compensates for PMT drift due to temperature, etc. The 
manual mode would require adjustment periodically as climate changes, etc. take place. 
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________________________________________________________________________________ 
3.3 AUTOMATIC GAIN ADJUSTMENT (CALIBRATION) 
 
The automatic PMT gain adjustment mode is enabled by setting the “PMT Gain Calibration Mode 
Enabled” to “YES” using the HSLRT6 set-up program. In addition the user must set the “Desired 
Calibrated Leaker Reject PMT value” for calibrated leak cans as well as the “Allowed Calibrated 
Leaker Reject Error” (deviation) from the specified calibrated leak can value. The “Desired 
Calibrated Leaker Reject PMT value” is typically set between 50 and 200. The “Allowed Calibrated 
Leaker Reject Error” (deviation) is typically set to 5. 
 
When the automatic gain feature is enabled, calibration is performed by stopping the machine and 
placing a calibrated leak can (a can with a .0025” calibrated leak hole) in the machine lined up 
exactly with the PMT. The calibration is initiated either from the “CALIBRATE” push-button 
inside the M4530 housing box or from the “CAL PMT GAIN” key on the HSL-RT6 
Keypad/Display. The M4530 will now generate a series of sync pulses and take a series of samples 
from the PMT. During this sampling process, the M4530 will adjust the gain of the PMT until the 
samples read from the PMT are equal to the number entered in the “Desired Calibrated Leaker 
Reject PMT value”, within the “Allowed Calibrated Leaker Reject Error”. The “CAL” LED on the 
front of the M4530 will flash while the calibration is in progress. Once the calibrate process is 
complete, the “CAL” LED on the front of the M4530 will either illuminate continuously, indicating 
the calibration was successful, or will extinguish, indicating a calibration error occurred. 
 
Note: When locating the calibrated leak can in front of the PMT, the can should be oriented with 
the .0025 hole in the least light intensive area. Generally this is with the hole facing the direction of 
movement of the can along the wheel. Thus when the M4530 is calibrated, it will be calibrated for 
the worst case lighting situation. 
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________________________________________________________________________________ 
3.4 CALIBRATION PROCEDURE 
 
Perform the following to calibrate the gain of the PMT: 
 
1) Stop the machine and place a calibrated leak can (a can with a .0025” hole) in the machine. 

With the can oriented with the .0025 hole facing the direction of movement of the can along the 
wheel, line the leak can up exactly with the PMT. 

 
Note: Orienting the can with .0025 facing the direction of movement along the wheel, places 
the hole at the least light intensive area of the PMT sampling station. This is done so that when 
the PMT is calibrated, it is calibrated for the worst case lighting situation. 

 
2) With the calibrated leak can positioned in front of the PMT, initiate the calibration either by 

pressing the “CALIBRATE” push-button inside the M4530 housing box or, with the “Set-Up 
Enable” switch in the “Enable” position, by pressing the “CAL PMT GAIN” key on the HSL-
RT6 Keypad/Display. 

 
3) The “CAL” LED on the M4530 will flash while the PMT gain calibration is taking place. The 

“CAL” LED will illuminate solid if the calibration is successful. If the calibration is not 
successful, the “CAL” LED will extinguish after the calibration was attempted. 

 
4) If a calibration error did occur (“CAL” LED on front of M4530 “off” at completion of the 

calibration procedure), observe the value of the PMT gain, either on the “M4530 Set-up” menu 
of the “HSLRT6” set-up program or the “View PMT Data” menu of the HSL-RT6 
Keypad/Display and verify the following: 

 
a) If the “PMT Gain” is less than 500 volts and the “Gain Calibrate PMT Input Average” is 

greater than the “Desired Calibrated Leaker Reject PMT Value” by more than 5, the PMT 
detected too much light and was not able to reduce the gain of the PMT adequately to 
compensate for the amount of light detected. Verify that the calibrated leaker has a .0025 or 
less calibration hole in it and does not have any other areas of leakage in the can. Verify that 
the seal at the pocket used for calibration is not leaking. Verify that no light leakage is 
occurring at any of the PMT seals (machine shutter to light seal plate, PMT to light seal 
plate, or at the PMT housing itself). 
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b) If the “PMT Gain” is at 1101 volts and the “Gain Calibrate PMT Input Average” is less than 
the “Desired Good Can PMT Value” by more than 5, then the PMT did not detect enough 
light and was not able to increase the gain enough to calibrate the M4530. Verify that the 
calibrated leaker has a .0025 calibration hole in it and verify that the light source is 
generating an adequate supply of light (lamps are “on” when calibration is performed). If so, 
set the “Desired Calibrated Leaker Reject PMT Value” to a lower value (it can be set as low 
as 10 above the “Desired Good Can PMT Value”) and try the calibration again. If the 
“Desired Calibrated Leaker Reject Value” is lowered, the “PMT Reject Can Threshold” 
should also be lowered (it should be between the “Desired Good Can PMT Value” and the 
“Desired Calibrated Leaker Reject Value”. 

 
5) Remove the calibrated leak can and restart the machine. With the machine running at normal 

speeds, run calibrated leak cans through the machine and verify that all the calibrated leak cans 
are rejected. If any are not rejected, repeat steps 1 through 3 using the calibrated leak cans 
which were not rejected. 
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________________________________________________________________________________ 
3.5 MANUAL GAIN ADJUSTMENT 
 
Manual PMT gain mode is enabled by setting the “PMT Gain Calibration Mode Enabled” to “NO” 
using the HSLRT6 set-up program. In this case, the user enters the absolute value of the PMT Gain 
after the automatic gain is disabled. The PMT Gain is set to a number between 500 and 1200volts. 
This corresponds to the voltage applied to the PMT.  
 
Note: The gain will round off to + or -5 volts of the value entered. 
 
As an alternative, the gain can be increased or decreased by 5 from the “View PMT Data” of the 
HSLRT6 set-up program or using the “ADJUST GAIN (INC GAIN / DEC GAIN)” key on the 
HSL-RT6 Keypad/Display. In this case, the gain can be adjusted manually regardless of whether the 
PMT auto gain calibration mode is enabled or disabled. 
 
Manually setting the PMT gain requires the user to run calibrated leakers through the machine to 
verify the PMT gain is set high enough to reject the calibrated cans. To set the gain, perform the 
following: 
 
1) Using the HSLRT6 set-up program view the M4530 PMT data and monitor the “Average Reject 

Value” and the last 8 rejects (“Last Reject Value” through “8th to Last Reject Value”). The 
“Average Reject Value” is the average of the last 8 rejects. 

 
2) Run some calibrated leak cans through the machine. The M4530 should reject all the cans. If the 

M4530 does not reject the cans, increase the “PMT Gain” (re-adjust the offset as well, if the 
manual offset mode is used - see section 3.2) and run the calibrated leakers through the machine 
again. Repeat this step until the M4530 always rejects the calibrated leakers. 

 
3) Now observe the “Average Reject Value” and the last 8 rejects while running the calibrated 

leakers through the machine. The calibrated leakers should result in a reject value of 
approximately 100 to 200. If the value is just barely above the reject threshold, increase “PMT 
Gain” until the calibrated leakers result in reject values in the range of 100 to 200. If the 
calibrated reject value is always higher than 230, decrease “PMT Gain” until the calibrated 
leakers typically have a reject value around 100 to 200. 

 
4) In general, the “PMT Gain” is set low enough where the calibrated leakers are easily detected 

but not so high that the M4530 becomes to sensitive and rejects good cans excessively. In 
addition, the higher the gain on the PMT, the shorter the life of the tube. As the tube ages, the 
sensitivity of the tube reduces, requiring the gain to be increased. 
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USING THE KEYPAD/DISPLAY 

The HSL-RT6 Keypad/Display contains 24 keys consisting of data display commands and set-up 
commands. The display is a 2 line by 40 character back-lit LCD display which displays the selected 
data and set-up menus. The Keypad/Display can be used to view data as well as to adjust the PMT 
“Gain” and “Threshold” (key switch protected). 
 

 

 
 
The display/keypad allows the following to be viewed or adjusted: 
 

1) Calibrate the PMT gain 
2) Increase/Decrease the PMT Gain 
3) Increase/Decrease the Reject Threshold 
4) View the PMT Set-up Data 
5) Set Machine Zero 
6) View the Number of Rejected Cans per Pocket 
7) View the Current Shift Data 
8) View the Last Shift Data 

 
The definitions of the keypad commands and menus are described in the following sections.  
 
Note: For virtually all the menus, the “NEXT” and “PREV” keys can be used to advance to the 
next item of the menu or return to the previous item on the menu. 
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________________________________________________________________________________ 
4.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) contains the following data: 
 

MACHINE SPEED (CPM):xxxx 
GOOD CANS:xxxxxxx          REJECTS:xxxxxx 

 
Where the “Machine Speed” is the current speed of the tester, the “Good Cans” field is the total 
number of good cans tested so far into the current shift, and the “Rejects” field is the total number 
of rejected cans for all pockets so far into the current shift. This display effectively replaces a speed 
meter, and two can counters. This screen is always returned to when no commands are active. 
 
 
________________________________________________________________________________ 
4.2 “REJECTS PER POCKET” KEY 
 
The number of rejected cans per pocket menu is provided to aid in the trouble-shooting of a bad seal 
with a particular pocket. The total number of rejected cans for each pocket since the last reset or end 
of shift is displayed. The operator can reset these counts at any time to aid in the trouble-shooting 
process (see section 4.3). The data can be viewed simply be pressing this key. The display shows a 
series of screens each with four pockets from 1 through 12 as shown below: 
 

-- REJECTED CANS PER POCKET -- 
1:xxxx       2:xxxx        3:xxxx        4:xxxx 

 
Where the numbers 1 through 4 are the first 4 pockets and the “xxxx” would be the actual counts 
for the respective pockets. Screens for pockets 5 thru 8, 9 thru 12 are shown in this fashion each for 
a time delay of 10 seconds. In addition, the user can advance to the next screen or retard to the 
previous screen by pressing the “NEXT” or “PREV” key respectively. 
 
The “ESC” key can also be used at any time to abort the rejects per pocket data display and return 
to the default screen. 
 
 
________________________________________________________________________________ 
4.3 “RESET REJECTS PER POCKET” KEY 
 
This key is used to reset the rejected cans per pocket counts that are displayed in the “Rejected Cans 
per Pocket” menu. When this key is pressed, the display will prompt “PRESS “ENTER” TO 
RESET THE REJECTS PER POCKET COUNTS OR “ESC” TO EXIT:”. Press the “Enter” key to 
reset the rejects per pocket counts. Press the “ESC” to exit without resetting the counts. The rejects 
per pocket counts collected for the current shift will not be reset when this key is hit. 
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________________________________________________________________________________ 
4.4 “CURRENT SHIFT” KEY 
 
The Current shift data menu displays the following information: 
 

Good Cans:xxxxxx  Rejects:xxxxx 
Rejected Cans per Pocket (1-12):xxxx 

 
This data is the totals so far into the shift. This data is transferred to the “Last shift” data when the 
end of shift input transfers from a “0” to a “1”. This can be at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such the data collected would be for label runs rather 
than complete shifts. This data cannot be reset by the operator, only at the end of shift input 
transition.  
 
Note: The Current shift “Good Cans” and “Rejects” is displayed as part of the default. 
 
Good Cans: This is the total number of good cans tested so far into the shift. This is essentially a 
can counter. 
 
Rejects: This is the total number of rejected cans for all pockets of the machine. 
 
Rejected Cans per Pocket (1:-12:): This is the total rejected cans for each pocket. A 
disproportionately high count for a particular pocket indicates a bad pocket seal for that pocket. 
 
 
________________________________________________________________________________ 
4.5 “LAST SHIFT” KEY 
 
The “Last Shift” data is identical to the current shift data except it is for the previous 8 or 12 hour 
shift or previous label run, however the shift collection is set-up. This allows data collection and 
diagnostics to take place automatically over a two-shift period.  
 
 
________________________________________________________________________________ 
4.6 “MANUAL REJECT” KEY 
 
The “MANUAL REJECT” key is used to manually reject cans from the tester either to test the 
reject solenoids or to reject cans for QC purposes. The tester will reject cans from either the odd or 
even solenoids as long as the “MANUAL REJECT” key is depressed. 
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________________________________________________________________________________ 
4.7 “VIEW PMT DATA” KEY 
 
The “View PMT Data” menu displays the following set-up variables: 
 

PMT GAIN (VOLTS): XXXX     PMT OFFSET: +XXX 
THRESHOLD: XXX    PMT AVERAGE: XXX    POS: XXX 

 
The data is shown in real time and reflects any change in value that may occur for each set-up 
parameter. To exit this menu, simply press “ESC” to return to the default menu. 
 
PMT Gain (Volts): This value adjusts the voltage applied to the tube, adjusting the gain. The 
value is set in 5-volt increments, from 498 to 1200. This parameter is adjusted when the PMT Gain 
calibration is performed (see section 4.8) or by adjusting the gain manually using the “ADJUST 
GAIN” key (see section 4.9). 
 
PMT Offset: This is the input offset value (between -250 and +250) and adjusts the M4530 input 
offset proportionally. This parameter is adjusted automatically in response to variations of the PMT 
offset (see section 3.1). 
 
Threshold: This value specifies the reject threshold. If the “PMT Input” value is below the 
threshold, the can is considered good and is not rejected. If the “PMT Input” value is above the 
threshold, the can is considered a leaker and is rejected. This parameter is typically set between 35 
and 75. This parameter is adjusted using the “ADJUST THRES” key (see section 4.10). 
 
PMT Average: This is the average of all good cans and the in-between pocket “dark” 
measurements for 36 consecutive cans. 
 
POS: This is the current angular position of the resolver in degrees. The resolver makes one 
revolution for one revolution of the shutter wheel (one revolution per 12 pockets). Thus there are 30 
degrees between pockets. This parameter is used to zero the machine (set the resolver zero, see 
section 4.11). 
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________________________________________________________________________________ 
4.8 “CALIBRATE GAIN” KEY 
 
This selection is used to execute the PMT Gain calibration procedure. When selected, the display 
will prompt: “PLACE CALIBRATED LEAKER AT THE PMT AND PRESS “ENTER” OR 
“ESC” TO EXIT:”.  
 
To calibrate the PMT gain:  
• Stop the tester 
• Align a calibrated leak test can at the PMT and press the “ENTER” key 
 
If the calibration is not to be performed, press the “ESC” key to return to the previous menu. 
 
If the “ENTER” key is pressed, the calibration will be performed per section 3.3. Once the 
calibration is initiated, the current gain in volts is displayed. If the calibration is successful, the 
display will display: “CALIBRATION COMPLETE, PRESS “ESC”. If the calibration is not 
successful, the display will show either: “CALIBRATION ERROR - NO LIGHT DETECTED” or 
“CALIBRATION ERROR - EXCESS LIGHT DETECTED”. See section 3.4 for details on the 
calibration error. 
 
Note: This selection is only enabled when the “SET-UP ENABLE” key switch is in the 
“ENABLE” position. 
 
 
________________________________________________________________________________ 
4.9 “ADJUST GAIN” KEY 
 
This selection is used to manually increase or decrease the PMT Gain. Once activated, the “INC 
GAIN” or “DEC GAIN” key is used to adjust the gain up or down (respectively) by 5 volts each 
time the corresponding key is depressed. Increasing the gain increases the sensitivity of the system, 
decreasing the gain decreases the sensitivity of the system. Once the gain has been adjusted as 
desired, press “ESC” to return to the previous menu. 
 
Note: This selection is only enabled when the “SET-UP ENABLE” key switch is in the 
“ENABLE” position. 
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________________________________________________________________________________ 
4.10 “ADJUST THRESHOLD” KEY 
 
This selection is used to increase or decrease the Reject Threshold. Once activated the “INC 
THRES” or “DEC THRES” key can be used to adjust the threshold up or down (respectively) by 
one each time the corresponding key is depressed. Increasing the threshold decreases the sensitivity 
of the system, decreasing the threshold increases the sensitivity of the system. Once the threshold 
has been adjusted as desired, press “ESC” to return to the previous menu. 
 
Note: This selection is only enabled when the “SET-UP ENABLE” key switch is in the 
“ENABLE” position. 
 
 
________________________________________________________________________________ 
4.11 “SET MACHINE ZERO” (SET RESOLVER OFFSET) KEY 
 
To zero the machine (set the resolver offset) perform the following: 
 
1) Select “VIEW PMT DATA” and observe the “POS:” field. Verify that as the machine is rotated 

forward that the position increases linearly from 0 through 359. If not, swap the S1 and S3 leads 
of the resolver at the M4530 resolver connector. Then verify that the position then indeed does 
increase with forward movement. 

 
2) Position the machine with pocket #1 perfectly aligned with the PMT. This is the machine zero 

position. 
 
3) Auto zero the resolver by pressing the “SET MACH ZERO” key. The display will prompt: “TO 

ZERO RESOLVER, ALIGN POCKET #1 WITH PMT AND PRESS “ENTER” OR “ESC” 
EXIT”. Press the “ENTER” key to set the resolver offset. The M4530 will calculate the actual 
offset value required to make this the 000 position. The View PMT Data menu will be 
displayed, now showing the “POS:” at zero. 

 
4) Press the “ESC” key to return to the default screen. 
 

Note: This selection is only enabled when the “SET-UP ENABLE” key switch is in the 
“ENABLE” position. 
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HSLRT6 WINDOWS BASED 

SETUP PROGRAM REFERENCE 
The Windows based set-up program is menu driven, allowing the user to easily view data, alter set-
up variables or set machine timing (machine offset, timing signal locations, etc.), using a PC 
running the Windows (95/98/ME/2000/XP/NT) operating system. The set-up variables are used to 
configure and tune the M4530 to match the configuration and performance of the specific tester (see 
Tuning the HSL-RT6-M45, section 2.12). 
 
Note:  The set-up program is an on-line communications program used to interface with the M4530 
module.  The data displayed and set in the windows is communicated directly to the module, while 
in the “Online” edit mode. Therefore, prior to going online with the processor, make sure an RS-
232 cable is connected from the COM port on the computer to the “PROG” port on the M4530.  
The variables displayed while in the “Online” edit mode are read directly from the processor.  Data 
is saved to a “Set-up Data” file (*.sdt) whenever changes are made to a parameter or if the data is 
uploaded from the processor. 
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HSLRT6 WINDOWS BASED 
SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
5.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar is used to display the name of 
the working “Set-up Data” file, as well as, the name of the active “Window”.  The title bar is dark if 
the window is active and grayed if another window is active.  The color depends on the settings of 
the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The status bar is used to display 
system messages, online or offline mode, as well as, the current time and date as set by the 
operating system.  The system messages panel displays general information about operation of the 
system.  The Online/Offline mode panel displays the status of the current set-up program mode of 
operation.  The mode of operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key and simultaneously pressing 
the underlined letter of the desired function.  Almost every function can be activated by either 
pressing a series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to make changes while “Online” 
with the processor.  The “Offline” mode is used to preset parameters prior to download.  All 
functions are available to the user while “Online”, however, specific “Online” functions are 
disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline Editing”, accessed under the “Edit” 
menu. 
 
Getting Help:  The entire contents of the user’s manual is contained within the help file.  Pressing 
Ctrl+H will display the help file window.  Pressing the F1 key will display the contents file.  Hot 
spots allow jumps to other topics to display additional information as desired.  Selecting About 
HSLRT6 from the Help menu will display a dialog box listing information about the current 
revision of the setup program and how to obtain technical support. 
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SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
5.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to the processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________________________________ 
5.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast file I/O operation.  When the 
set-up program is first invoked, the default set-up parameters are loaded into memory.  If changes 
are made to any of the set-up parameters (either online or offline), as well as shift data, the user will 
be flagged to “Save Changes” upon exit of the program. 
 
Note:  Any windows based “Set-up” program can open a set-up “Data File”, however, the data 
tables will not be properly aligned.  The user will be alerted to the problem if a set-up data file has 
been created by either a different set-up program or a different revision of the software. 
 
The set-up “Data File” is similar to that of a word processing file.  When the program first starts, 
the default parameters are loaded and the user is able to make changes as desired.  The set-up 
program is unaware of the settings and parameters that exist within the M4530.  Therefore, to 
normalize the set-up program with the processor, the user should define or open an existing file, 
then upload “All” variables from the processor.  This allows the user to either create a backup of the 
data or maintain an existing file.  The user can even open a data file for another tester, save the file 
to a new name, make the necessary changes and simply download the new parameters to another 
processor. 
 
The following functions can be accessed any time, from any set-up or display windows. 
New:  To create a “New” data file, select “New” from the “File” menu or press “Ctrl + N”.  This 
creates a completely new file, loaded with the default variables and the word “[unnamed]” is 
displayed in the title bar.  If any changes were made to the existing file, the user is prompted to save 
changes to the existing file. 
 
Open:  To “Open” an existing data file, select “Open” from the “File” menu or press “Ctrl + O”.  
This displays a dialog box allowing the user to select an existing data file. The name of the file will 
then be displayed in the title bar.  If any changes are made to the parameters (including shift data), 
the user will be prompted to save any changes before terminating the program. 
 
Save:  To “Save” the data to disk, select “Save” from the “File” menu or press “Ctrl + S”.  This 
displays a dialog box allowing the user to select a folder and enter a name for the file.  The user will 
be notified if the file exists. The extension “.sdt” will automatically be added to the file name.  If 
this is a “New” file, the user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” from the “File” menu..  This 
displays a dialog box allowing the user to select a folder and enter in a new name for the file.  The 
user will be notified if the file exists and the extension “.sdt” will automatically be added to the file 
name. 
 
Export Shift Data…:  This function allows the user to export the shift data to a “Tab Delimited” 
text file.  This allows the user to easily use the shift data to produce production reports. 
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SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
5.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload set-up parameters, timing channel set-points and 
shift data from the M4530 into a set-up “Data File”.  This function is accessed from the “File” menu 
and the user is given the choice of the following options: 
 

 
 
 
M4530 PROG Port:  This option allows the user to upload set-up parameters, timing channel set-
points and shift data from the M4530. If not connected to the M4530 PROG port, a message will be 
displayed alerting the user. 
 
S4030 CAL Port:  This option allows the user to upload PMT set-up parameters and data from the 
S4030 PMT processor board. If not connected to the S4030 CAL port, a message will be displayed 
alerting the user. 
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________________________________________________________________________________ 
5.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” the HSLRT6 SYSdev program to the M4530. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the program must be “Online”.  If 
“Online” mode cannot be achieved, program download will not be executed.  If the program is 
currently “Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and “Online” with the processor, a dialog box will be displayed, allowing the user to 
select the SYSdev file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  It is important to keep in 
mind that only a valid M4530 PLC SYSdev file can be downloaded with the set-up program.  Care 
should be taken when selecting a program to download. 
 
If not connected to the M4530 PROG port, a message will be displayed alerting the user.  
 
Once selected, a message box is displayed informing the user of the current program, revision and 
checksum of the program loaded in the processor, as well as, that of the selected program.  The user 
must confirm their selection by clicking the “Yes” command button.  After the user confirms their 
choice, program download is initiated and the current program download address is displayed.  
When program download is complete, the user is prompted to acknowledge.  Control is passed back 
to the main program and the set-up program remains in an “Online” edit mode. 
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SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
5.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” parameters, timing channel set-points 
and shift data to the M4530 and S4030 from the set-up “Data File”.  This function is accessed from 
the “File” menu and the user is given the choice of the following options: 
 

 
 
M4530 PROG Port:  This option allows the user to download the set-up parameters, timing 
channel set-points and shift data to the M4530.  If not connected to the M4530 PROG port, a 
message will be displayed alerting the user. 
 
S4030 CAL Port:  This option allows the user to download the PMT set-up parameters to the 
S4030 PMT Processor board.  If not connected to the M4530 PROG port, a message will be 
displayed alerting the user. 
 
Note:  Only the values contained within the current data file are used.  If the validity of the current 
data file is questionable, review the data in an “Offline” mode prior to download. 
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________________________________________________________________________________ 
5.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout of all the set-up parameters, 
timing channel set-points and shift data.  This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file being printed.  At the bottom 
of each page is the date and time the document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  This displays the “Print Setup” 

dialog box, allowing the user to select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the specified printer device.  This 
function makes use of the windows print manager, which allows the user to continue with their 
work while the document is being printed. 

 
 
________________________________________________________________________________ 
5.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
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________________________________________________________________________________ 
5.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the currently loaded set-up data file.  
This allows the user the ability to make any necessary changes to the set-up parameters while not 
online with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-up parameters and shift data.  
When the program is first invoked, the default setting is offline editing disabled.  The user will need 
to select “Enable Offline Editing” from the edit menu (or press function key F2) to enable/disable 
this feature. 
 
 
________________________________________________________________________________ 
5.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications port and rate to talk to the 
M4530.  The programming port of the M4530 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm Port” and “Baud Rate” will be 
displayed.  The default setting is COM1 at 9600 baud.  The option to select the 19200 baud rate is 
to allow the user to communicate with the processor via the S4516 serial communications board. 
 
In most cases, the user will only need to specify the communications port and leave the baud rate at 
9600.  If communication problems occur, make sure there is a secure connection from the PC to the 
PLC.  Then check the Comm port.  In most cases, the user will only need to select a new Comm 
port.  If communication problems persist, there may be another program causing a conflict with the 
port.  Check the port configuration from the Windows “Settings” folder. 
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5.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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5.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network communication error codes and 
review the current “Ident” and “Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a program to compare with the one 
existing in the processor.  Whether a program is selected or the user cancels, the setup program will 
attempt to communicate with the M4530.  If unsuccessful, a warning message will be displayed, 
prompting the user to either “Retry” or “Cancel” the operation.  If the operation is canceled and 
communication with the processor cannot be established the system will be placed in an “Offline” 
mode, however the “Target Board Interface” window will be displayed. 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- 47 - 



SECTION 5 
HSLRT6 WINDOWS BASED 
SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
5.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an “Online” mode with the processor.  
This is accessed by the “View” menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” by simply double clicking on 
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm port and communicate with the 
M4530.  If the set-up program is unsuccessful, a warning message will be displayed prompting the 
user to either “Retry” or “Cancel” the operation.  If the operation is canceled and communication 
with the processor cannot be established the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the processor and communication is 
interrupted, a warning message will be displayed, prompting the user to either “Retry” or “Cancel” 
the operation. 
 
 
________________________________________________________________________________ 
5.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an “Offline” mode.  This is accessed by 
the “View” menu, by selecting “Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in “Offline” edit mode reflect the 
actual values contained in the currently loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” by simply double clicking on 
the “Online” or “Offline” panel displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease communication with the 
M4530. 
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5.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of five different Display/Set-up windows to 
modify set-up parameters, view shift data or receive feedback about the current status of the control 
system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to the selected item and the 
selected window is displayed with the name changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray background.  Any variables that can 
be altered by the user are displayed in black with a white background.  In most cases, a parameter 
that can be changed by the user will have associated with it increment and decrement controls.  The 
user can either click on the desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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5.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the control system.  This 
window is selected from the “Window” menu. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It displays alarm and status 
messages specific to the M4530, as well as, the current “Online” or “Offline” status of the set-up 
program  By simply scrolling the display, the user is able to view all active alarm and status 
messages.  If no alarm or status messages are active, a default message is displayed. 
 
Machine CPM:  This display is only active while “Online” and displays the current speed of the 
tester in “Cans Per Minute”. 
 
Good Cans:  This display is the “Current Shift” good can count.   
 
Rejects:  This display is the “Current Shift” total reject count. 
 
PMT Applied Gain (Volts): This is the voltage applied to the tube. The value is set in 5-volt 
increments, between 498 and 1200. This parameter is adjusted when the PMT Gain calibration is 
performed. It can also be adjusted manually using the up/down increment control. Adjusting this 
value adjusts the gain of the tube. 
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Adjusting the PMT Gain:  This selection is used to manually increase or decrease the PMT 
Gain. Once online with the M4530 through the PROG port, this control is active.  The up/down 
increment control can be used to adjust the gain by 5 volts each time the corresponding key is 
depressed. Increasing the gain will increase the sensitivity of the system, decreasing the gain will 
decrease the sensitivity of the system.  
 
PMT Offset: This is the input offset value (between -250 and +250) and adjusts the M4530 input 
offset proportionally. This parameter is adjusted automatically in response to variations of the PMT 
offset (see section 3.1 – Automatic Offset Adjustment). 
 
Threshold: This value specifies the reject threshold. If the “PMT Input” value is below this 
threshold, the can is considered good and is not rejected. If the “PMT Input” value is above this 
threshold, the can is considered a leaker and is rejected. Typically, this parameter is set between 35 
and 75. This parameter is adjusted using the up/down increment control 
 
Adjusting the Threshold:  This selection is used to increase or decrease the Reject Threshold. 
Once online with the M4530 through the PORG port this control is active.  The up/down control 
can be used to adjust the threshold by one each time the corresponding key is depressed. Increasing 
the threshold will decrease the sensitivity of the system, decreasing the threshold will increase the 
sensitivity of the system.  
 
PMT Average: This is the average of all good cans and the in-between pocket “dark” 
measurements for 36 consecutive cans. 
 
Calibrate PMT:  This selection is used to execute the PMT Gain calibration procedure. If the 
calibration is to be performed, stop the tester, align a calibrated leak test can at the PMT and select 
the “Calibrate PMT” button.  
 
If the button is pressed, the calibration will be performed (see section 3.3 – Automatic Gain 
Adjustment, Calibration). Once the calibration is initiated, the message display will show  “PMT 
Gain Calibration In Progress”.  The applied PMT gain will display the current gain in volts. If the 
calibration is not successful, the message display will show “Calibration Error”. See section 3.4 – 
Calibration Procedure, for details on the calibration error. 
 
Note: This function is only available while online with the processor through the PROG port and 
the tester is stopped. 
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5.5.2 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming command menus.  From this 
window, the user can view or adjust the following parameters: 
 
• Adjust Timing Channel setpoints. 
• Set the resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 
In addition, the following parameters are displayed at the bottom of this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
 
Scale:  This is the scale factor of the resolver or the number of divisions in one revolution. 
 
Note:  The General Timing Signal Locations section provides a complete description of each 
timing channel signal. 
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Zeroing the Machine (setting the resolver offset):  To set the machine zero (resolver offset) 
perform the following: 

 
1) Connect the RS-232 cable from the COM port on the computer to the “PROG” port on the 

M4530 and go online with the processor. 
 
2) From the “View” menu, select “Online Data”.  The set-up program will attempt to communicate 

with the processor and place the system into an “Online” mode of operation. 
 
3) Observe the “POS:” field. Verify that as the machine is rotated forward that the position 

increases linearly from 0 through 359. If not, swap the S1 and S3 leads of the resolver at the 
M4530 resolver connector. Then verify that the position then indeed does increase with forward 
movement.  

 
4) Position the machine with pocket #1 perfectly aligned with the PMT. This is the machine zero 

position. 
 
5) Auto zero the resolver by entering “0” in the offset field and then “Click” the “Set Offset” 

button. 
 
6) The M4530 will calculate the actual offset value required to make this the 000 position and will 

display this number in the offset field. The position will now read 0. 
 
 Note:  The offset can only be changed while online with the processor with the machine 

stopped. 
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Adjusting the Timing Channel Setpoints:  To set any of the timing signal setpoints, perform 
the following: 
 
Note:  Any changes made to the timing channel setpoints will be saved as part of the setup data 
file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the computer to the “PROG” port on 

the M4530.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up program will attempt to communicate 

with the processor and place the system into an “Online” mode of operation. 
 
4) Set-points are entered for a particular channel simply by typing in the set-point. 
 
 Note: CH00 (Sync timing) and CH01 (Marker timing) are automatically programmed at power-

up and should not be modified by the user. Only CH02 thru CH07 can be programmed by the 
user if additional timing signals are required by the user (these channels are not used by the 
HSLRT6 program).  Only one set-point is can be programmed per channel.  

 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired channel number into the 

“PLS Channel” field.  Click the “Recall Channel” command button to recall the setpoints.  Click 
the “Clear Channel” command button the completely clear all setpoints for the selected channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” setpoints have the same setting, the 

set-point will be displayed as “*****”. 
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Resetting the PLS Configuration:  As an aid to the user the current PLS configuration is 
displayed in the “PLS Configuration” tab of this window.  The PLS configuration should only be 
reset if a new module has been installed.  To reset the PLS configuration, click the “Reset PLS 
Config” command button.  This function only resets the PLS configuration to the default settings. 
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5.5.3 THE SERIAL COMMUNICATIONS WINDOW 
 
The Serial Communications window is used to view the configuration status of the S4516 serial 
communications board (if installed), as well as, view the status of the Allen-Bradley DF1 
communication protocol and set-up the Allen-Bradley PLC communication parameters.  From this 
window the user can view or adjust the following parameters: 
 
• View the S4516 configuration status. 
• View the S4516-DF1 serial communication status. 
• View the Allen-Bradley Link Layer serial communication status. 
• Select the Allen-Bradley PLC type (PLC5 or SLC500) to communicate to. 
• View/Set the Allen-Bradley PLC destination node. 
• Select the starting Allen-Bradley PLC destination file number. 
 

 
 
S4516 Configuration Status:  This displays the current state of the configuration of the S4516 
serial communications board.  System function sfunc19(); (S4516 configuration) is used to set the 
S4516 configuration (network node address, network baud rate and USER port baud rate).  This 
must be executed prior to executing ether system functions 10, 11 or 13.  System function 19 is 
generally executed in the “Initialization” file of the user program. 
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The following values are returned from a system function 19 call: 
 1 = Busy. 
 2 = Done (S4516 Successfully configured). 
 3 = Invalid Parameter (either network node address, network baud rate or USER port baud 

rate is invalid). 
 4 = Timeout (no response form S4516) 
 32 = Hardware ACK error from S4516 
 34 = Invalid S4516 Slot Address (W8156 must be loaded with the slot address of the S4516, 

prior to executing system function 19). 
 
Transmit Data Status:  This represents the state of the data packet transmission. This will 
typically display either “Busy” or “Done”.  If there are problems delivering the message packet, the 
response code, along with a description, will be displayed. 
 
Note:  The “Transmit Data Status (prev.)” is used to view the last or previous status. 
 
Current Transaction:  This is the “Transaction” number delivered to the Allen-Bradley PLC. 
 
Active Command:  This displays either “Read” or “Write”.  This is used to view the command 
type of the current transaction. 
 
Number of  BYTES Received:  This displays the current number of bytes received from either a 
“Command” or “Reply” message packet. 
 
Received Command BIT Status:  This displays the state of the command received.  If this 
displays a “Reply”, then the command was sent from the M4530.  If this displays “Command”, then 
a command action was received by the M4530. 
 
A/B Link Layer Status:  This displays the status of the receipt of the message packet sent to the 
Allen-Bradley PLC.  If the delivery is not successful, an error code along with a description is 
displayed.  Refer the to the Allen-Bradley Communication Protocol and Command Set reference 
manual for more information on “Link Layer” error codes. 
 
A/B Link Layer – Current Transaction Received:  This is the “Transaction” number received 
from the Allen-Bradley PLC. 
 
PLC Type:  This is used to specify the “Type” of PLC the M4530 will communicate to.  The user 
can choose from “PLC5” or “SLC500”. 
 
Note:  This parameter should be set prior to communicating with an A/B processor. 
 
Destination Node:  This is used to set the node number of the A/B PLC to send and receive data 
from.  This also displays the node number of the A/B PLC that send a “Command” message packet. 
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Destination File Number:  This is the file number the M4530 will read and write data from.  See 
Appendix B for a description of the data read from and written to an Allen-Bradley PLC. 
 
 
________________________________________________________________________________ 
5.5.4 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by the M4530.  This window is 
selected from the “Window” menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters into three categories, similar 
to that of the Keypad/Display.  These sections are as follows: 
 
Rejects Per Pocket: The number of rejects per pocket menu is provided to aid in the trouble-
shooting of a bad seal with a particular pocket. The total number of rejects for each pocket since the 
last reset or end of shift is displayed. The user can reset these counts at any time to aid in the 
trouble-shooting process. 
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Current Shift Data:  This section is used to view the “Current Shift” data.  This data is the totals 
so far into the shift.  This data is transferred to the “Last shift” at the end of either an 8 or 12 hour.  
This data can be reset by the user from this section. 
 

 
 
Note:  The “Transfer Data” command button is only active while “Online”.   
 
The Current shift data menu displays the following information: 
 
1) Total Good Cans Processed: 
 
2) Total Rejected Cans (for all pockets): 
 
 Number of Rejected Cans (for each pocket): 
 Pocket #1: 
     thru 
 Pocket #12: 
 
This data is the totals so far into the shift. This data is transferred to the “Last shift” data when the 
end of shift input transfers from a “0” to a “1”. This can be at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such that the data collected would be for label runs 
rather than complete shifts. 
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Last Shift Data:  The “Last Shift” data is identical to the current shift data except it is for the 
previous 8 or 12 hour shift or previous label run, however the shift collection is set-up.  This allows 
data collection and diagnostics to take place automatically over a two shift period. 
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5.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs and outputs.  The control 
boards, the states of the timing channels, as well as states of the M4530 are shown.  This includes 
the interrupt inputs (IN0 and IN1), the analog I/O and the resolver.  These values are displayed as 
read by the M4530 processor. 
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5.6 THE PMT WINDOW 
 
The “PMT” window is used to view and adjust any of the PMT setup parameters. 
 

 
 
Note: Prior to selecting PMT window, make sure the RS-232 cable is connected from the COM1 
port on the computer to the CAL PORT on the M4530. 
 
This window utilizes a “TAB” control to divide the set-up parameters into two categories.  These 
sections are as follows: 
 
PMT Setup Parameters:   
1) Automatic Offset Mode Enabled: When “Checked”, the automatic offset mode is enabled 

(see section 3.1 – Automatic Offset Adjustment). When “Unchecked”, the manual offset mode 
is enabled (see section 3.2 – Manual Offset Adjustment). 

 
2) PMT Input Offset (-250 to 250): This is the input offset value and adjusts the M4530 input 

offset proportionally. This parameter is set by the user in manual offset mode or is adjusted 
automatically when in the automatic offset mode. 

 
3) Desired Good Can PMT Value: Used in the automatic offset mode. This value is set by the 

user to specify the desired good can average. The M4530 adjusts the input offset until the 
average good can input is within the specified error (see section 3.1 – Automatic Offset 
Adjustment). 
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4) Allowed Good Can Error: This parameter is used in conjunction with the "Desired Good 

Can PMT Value" to adjust the PMT input offset in the automatic offset mode. The M4530 will 
adjust the offset until the good can average is within the value entered in "Allowed Good Can 
Error" of the "Desired Good Can PMT Value". 

 
5) PMT Gain Calibration Mode Enabled: When “Checked”, the “Automatic Gain 

Calibration” mode is enabled (see section 3.3 – Automatic Gain Adjustment).  When 
“Unchecked”, the “Manual Gain” mode is enabled (see section 3.5 – Manual Gain Adjustment). 

  
6) Gain Calibrate PMT Input Average: This is the average PMT input value of the last 6 

samples taken while a calibration cycle is in process. The M4530 compares this value to the 
"Desired Calibrated Leaker Reject PMT Value" and adjusts the PMT gain accordingly while a 
calibrate cycle is in progress (see section 3.4 – Calibration Procedure). 

 
7) Desired Calibrated Leaker Reject PMT Value: Used in the auto gain mode. This value is 

set by the user to specify the desired reject average. The M4530 adjusts the PMT gain until the 
average calibrate value is within the specified error. 

 
8) Allowed Calibrated Leaker Reject Error: This parameter is used in conjunction with the 

"Desired Calibrated Leaker Reject PMT Value" to adjust the PMT gain in the auto gain mode. 
The M4530 will adjust the gain until the calibrate average is within the value entered in 
"Allowed Calibrated Leaker Reject Error" of the Desired Calibrated Leaker Reject PMT Value" 
(see section 3.3 – Automatic Gain Adjustment). 

 
9) PMT Reject Can Threshold: This value specifies the reject threshold. If the "PMT Input" 

value is below this threshold, the can is considered good and is not rejected. If the "PMT Input" 
value is above this threshold, the can is considered a leaker and is rejected. Typically this 
parameter is set between 35 and 75. 

 
10) PMT Gain (PMT Voltage 0-1200V): Adjusting this value adjusts the voltage applied to the 

tube, thus adjusting the gain of the tube. The value is set in 5 volt increments, thus when a 
number is entered, it will be rounded to the nearest 5 volt increment. This parameter is set by 
the user in manual gain mode (see section 3.5 – Manual Gain Adjustment) or is adjusted 
automatically when calibration is performed in the auto gain mode (see section 3.3 – Automatic 
Gain Adjustment). 

 
11) M4530 PMT Input Sensitivity: This is a value, from 0 to 7, which adjusts how much the 

output from the PMT (input to the M4530) is amplified internally in the M4530. The higher the 
number, the higher the M4530 sensitivity will be. In general, this is set at the highest 
amplification and is only lowered if the PMT is too sensitive.
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View PMT Data:  The “View PMT Data” selection is used to view the good can and reject 
data in real time as well as manually fine tune the PMT gain. 

 

 
 
1) PMT Gain: This value adjusts the voltage applied to the tube, thus adjusting the gain of the 

tube. The value is set in 5 volt increments, thus when a number is entered, it will be rounded to 
the nearest 5 volt increment. This parameter is set by the user in manual gain mode or adjusted 
automatically when a calibration is preformed in the auto gain mode or is incremented or 
decremented by 5 from this menu. 

 
2) PMT Offset: This is the input offset value and adjusts the M4530 input offset proportionally. 

This parameter is set by the user in manual offset mode or is adjusted automatically when in the 
automatic offset mode. 

 
3) PMT Input: This is the value (0 to 255) of the last PMT sample and is proportional to the 

amount of light detected by the PMT where 0 equals no light detected and 255 equals maximum 
light detected. 

 
4) PMT Input Average: This is the average of all good cans and the in-between pocket "dark" 

measurements for 36 consecutive cans. 
 
5) PMT Up Deviation: This is the average up deviation from the good can "PMT Input Average" 

for 36 consecutive cans. The lower the number, the less deviation between all good cans, the 
higher the number, the more deviation. 
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6) PMT Down Deviation: This is the average down deviation from the good can "PMT Input 

Average" for 36 consecutive cans. The lower the number, the less deviation between all good 
cans, the higher the number, the more deviation. 

 
7) Up Deviation Count: This is the number of good cans that deviated up from the good can 

"PMT Input Average" in the last 36 consecutive pockets. 
 
8) Down Deviation Count: This is the number of good cans that deviated down from the good 

can "PMT Input Average" in the last 36 consecutive pockets. 
 
9) Up Peak (Max): This is the highest PMT input value detected as a good can in the last 36 

consecutive pockets. 
 
10) Down Peak (Min): This is the lowest PMT input value detected as a good can in the last 36 

consecutive pockets. 
 
11) Average Reject Value: This is the average value of the PMT input for the last 8 rejects. 
 
12) # of Rejects (of Last 36 cans): This is the number of leakers (rejects) detected in the last 36 

consecutive pockets. 
 
13) Last Reject Value through 8th to Last Reject Value: These 8 variables are a stack that 

contain the values of the last 8 rejects. 
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The “HSLRT6” set-up program is a DOS based menu driven program which allows the user to 
easily view the HSL-RT6-M45 data or alter the HSL-RT6-M45 set-up variables using an IBM PC 
or compatible. In addition to setting the set-up variables, “HSLRT6” can be used to set the machine 
timing (machine offset, timing signal locations, etc.). The set-up variables are used to configure and 
tune the HSL-RT6-M45 to match the configuration and performance of the specific light tester (see 
section 2.12 – Tuning the HSL-RT6-M45). 
 
The main menu of the “HSLRT6” set-up program incorporates the following menu selections: 
 

 
 
Note: The “HSLRT6” program is an on-line communications program used to interface with the 
M4530 module. The data displayed in the menus and set in the menus is communicated directly to 
the M4530. Therefore, prior to selecting any of the above selections, make sure an RS-232 cable is 
connected from the COM port on the computer running “HSLRT6” to the respective port (“CAL” 
or “PROG”) on the M4530 as indicated in the selection. 
 
The following sections are a complete description of the “HSLRT6” selections and menus. 
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6.1 M4530 SET-UP MENU (CAL PORT) 
 
The M4530 Set-up Menu is used to set the offset and gain modes of the M4530 as well as the reject 
threshold. This menu is invoked by selecting “1: M4530 Set-up (CAL PORT)” from the Main 
Menu.  
 
Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM1 
port on the computer to the CAL PORT on the M4530. 
 

 
 
 
PMT Gain (PMT Voltage 0-1200V): This value adjusts the voltage applied to the tube, thus 
adjusting the gain of the tube. The value is set in 5 volt increments, thus when a number is entered, 
it will be rounded to the nearest 5 volt increment. This parameter is set by the user in manual gain 
mode (see section 3.5) or is adjusted automatically when calibration is performed in the auto gain 
mode (see section 3.3). 
 
Gain Calibrate PMT Input Average: This is the average PMT input value of the last 6 samples 
taken while a calibration cycle is in process. The M4530 compares this value to the “Desired 
Calibrated Leaker Reject PMT Value” and adjusts the PMT gain accordingly while a calibrate cycle 
is in progress (see section 3.4). 
 
M4530 PMT Input Sensitivity: This is a value, from 0 to 7, which adjusts how much the output 
from the PMT (input to the M4530) is amplified internally in the M4530. The higher the number, 
the higher the M4530 sensitivity will be. In general, this is set at the highest amplification and is 
only lowered if the PMT is too sensitive. 
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PMT Input Offset (-250 to 250): This is the input offset value and adjusts the M4530 input 
offset proportionally. This parameter is set by the user in manual offset mode (see section 3.2) or is 
adjusted automatically when in the auto offset mode (see section 3.1). 
 
PMT Reject Can Threshold: This value specifies the reject threshold. If the “PMT Input” value 
is below this threshold, the can is considered good and is not rejected. If the “PMT Input” value is 
above this threshold, the can is considered a leaker and is rejected. Typically this parameter is set 
between 35 and 75. 
 
Automatic Offset Mode Enabled: When set to “YES”, the automatic offset mode is enabled 
(see section 3.1). When set to “NO”, the manual offset mode is enabled (see section 3.2). 
 
Desired Good Can PMT Value: Used in the auto offset mode. This value is set by the user to 
specify the desired good can average. The M4530 adjusts the input offset until the average good can 
input is within the specified error (see section 3.1). 
 
Allowed Good Can Error: This parameter is used in conjunction with the “Desired Good Can 
PMT Value” to adjust the PMT input offset in the auto offset mode. The M4530 will adjust the 
offset until the good can average is within the value entered in “Allowed Good Can Error” of the 
“Desired Good Can PMT Value” (see section 3.1). 
 
PMT Gain Calibration Mode Enabled: When set to “YES”, the automatic gain calibration 
mode is enabled (see section 3.3). When set to “NO”, the manual gain mode is enabled (see section 
3.5). 
 
Desired Calibrated Leaker Reject PMT Value: Used in the auto gain mode. This value is set 
by the user to specify the desired reject average. The M4530 adjusts the PMT gain until the average 
calibrate value is within the specified error (see section 3.3). 
 
Allowed Calibrated Leaker Reject Error: This parameter is used in conjunction with the 
“Desired Calibrated Leaker Reject PMT Value” to adjust the PMT gain in the auto gain mode. The 
M4530 will adjust the gain until the calibrate average is within the value entered in “Allowed 
Calibrated Leaker Reject Error” of the Desired Calibrated Leaker Reject PMT Value” (see section 
3.3). 
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6.2 VIEW M4530 PMT DATA (CAL PORT) 
 
The View M4530 Data Menu is used to view the good can and reject data in real time as well as 
manually fine tune the PMT gain. This menu is invoked by selecting “2: View M4530 PMT Data 
(CAL PORT)” from the Main Menu.  
 
Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM1 
port on the computer to the CAL PORT on the M4530. 
 

 
 
 
PMT Gain: This value adjusts the voltage applied to the tube, thus adjusting the gain of the tube. 
The value is set in 5 volt increments, thus when a number is entered, it will be rounded to the 
nearest 5 volt increment. This parameter is set by the user in manual gain mode (see section 3.5), is 
adjusted automatically when calibration is preformed in the auto gain mode (see section 3.3), or is 
incremented or decremented by 5 from this menu. 
 
PMT Offset: This is the input offset value and adjusts the M4530 input offset proportionally. This 
parameter is set by the user in manual offset mode (see section 3.2) or is adjusted automatically 
when in the auto offset mode (see section 3.1). 
 
PMT Input: This is the value (0 to 255) of the last PMT sample and is proportional to the amount 
of light detected by the PMT where 0 equals no light detected and 255 equals maximum light 
detected. 
 
PMT Input Average: This is the average of all good cans and the in-between pocket “dark” 
measurements for 36 consecutive cans. 
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PMT Up Deviation: This is the average up deviation from the good can “PMT Input Average” for 
36 consecutive cans. The lower the number, the less deviation between all good cans, the higher the 
number, the more deviation. 
 
PMT Down Deviation: This is the average down deviation from the good can “PMT Input 
Average” for 36 consecutive cans. The lower the number, the less deviation between all good cans, 
the higher the number, the more deviation. 
 
Up Deviation Count: This is the number of good cans that deviated up from the good can “PMT 
Input Average” in the last 36 consecutive pockets. 
 
Down Deviation Count: This is the number of good cans that deviated down from the good can 
“PMT Input Average” in the last 36 consecutive pockets. 
 
Up Peak (Max): This is the highest PMT input value detected as a good can in the last 36 
consecutive pockets. 
 
Down Peak (Min): This is the lowest PMT input value detected as a good can in the last 36 
consecutive pockets. 
 
Average Reject Value: This is the average value of the PMT input for the last 8 rejects. 
 
# of Rejects (of Last 36 cans): This is the number of leakers (rejects) detected in the last 36 
consecutive pockets. 
 
Last Reject Value through 8th to Last Reject Value: These 8 variables are a stack that 
contain the values of the last 8 rejects. 
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6.3 SET MACHINE TIMING (PROG PORT) 
 
The Set Machine Timing selection is used to invoke the PLS programming command menus (these 
are the same menus used in SYSdev to program the PLS section of the M4530). When selected, the 
PLS programming main development menu will be invoked using the default RT6TMG channel 
set-point file. From this menu, the user can zero the machine (set the resolver offset) and adjust the 
timing signal set-points of CH02 thru CH07 (additional user channels if used).  
 
Note: CH00 (Sync timing) and CH01 (Marker timing) are automatically programmed at power-up 
and should not be modified by the user. The following sections describe how to perform these 
functions. Also, prior to selecting the Machine Timing selection, make sure the RS-232 cable is 
connected from the COM port on the computer to the PROG PORT on the M4530. 
 

 
 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- 72 - 



SECTION 6 
HSLRT6 DOS BASED 

SETUP PROGRAM REFERENCE 
________________________________________________________________________________ 
6.3.1 ZEROING THE MACHINE 
 
To set the machine zero (resolver offset) perform the following: 
 
1) From the HSLRT6 set-up program main menu, select “3: Set Machine Timing” selection. 
 
2) Select “1: Online Channel Setpoint Programming”. 
 
3) Select “F9: POS/RPM” and observe the “POS:” field. Verify that as the machine is rotated 

forward that the position increases linearly from 0 through 359. If not, swap the S1 and S3 leads 
of the resolver at the M4530 resolver connector. Then verify that the position then indeed does 
increase with forward movement. Press “ESC” to exit the “POS/RPM” update. 

 

 
 
4) Position the machine with pocket #1 perfectly aligned with the PMT. This is the machine zero 

position. 
 
5) Auto zero the resolver by selecting “F10: Set Offset”. Enter “0” in the offset field and press 

<ENTER>. The M4530 will calculate the actual offset value required to make this the 000 
position and will display this number in the offset field. The position will now read 0. 

 
6) Exit back to the PLS Main Development menu by pressing <ESC>. Exit back to the “HSLRT6” 

set-up main menu by pressing <ESC> again. 
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6.3.2 ADJUSTING THE TIMING CHANNEL SET-POINTS 
 
To set or alter any of the timing signal (CH02 thru CH07) set-points, perform the following: 
 
1) From the HSLRT6 set-up program main menu, select the “3: Set Machine Timing” selection. 
 
2) Select “1: Online Channel Setpoint Programming”. 
 
3) Set-points are entered for a particular channel by typing in the set-point in the form XXX-

YYY<ENTER> in the first set-point of the given channel. The XXX is the location the set-point 
will turn “on” while YYY is the location where the set-point will turn “off”. Use the PgUp, 
PgDn, F1:Next Chan, or F2: Prev Chan keys to select the desired channel for programming. 

 
4) Once the desired channels are programmed, press <ESC> to exit back to the PLS Main 

Development Menu. Press <ESC> again to exit back to the “HSLRT6” set-up main menu. The 
new channels will be saved both in the M4530 and in the “RT6TMG” file on the hard drive. 

 
Note: CH00 (Sync timing) and CH01 (Marker timing) are automatically programmed at power-
up and should not be modified by the user. Only CH02 thru CH07 can be programmed by the 
user if additional timing signals are required by the user (these channels are not used by the 
HSLRT6 program). 
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6.4 NUMBER OF REJECTS PER POCKET DATA (PROG PORT) 
 
The number of rejects per pocket menu is provided to aid in the trouble-shooting of a bad seal with 
a particular pocket. The total number of rejects for each pocket since the last reset or end of shift is 
displayed. The operator can reset these counts at any time to aid in the trouble-shooting process. 
 
This menu is invoked by selecting “4: Number of Rejects per Pocket Data” from the Main Menu.  
 

 
 
Note: Prior to selecting this selection, make sure the RS-232 cable is connected from the COM port 
on the computer to the “PROG” port on the M4530. 
 
When selected from the main menu, the total rejects per pocket is displayed and updated 
continuously in fields that read “Pocket #xx...:”. To exit back to the main menu, press <ESC>.  
 
Note: A disproportionately high count for a particular pocket indicates a sealing problem for that 
pocket. 
 
To reset the pocket reject counts, simply press “1”. The counts will be reset in the M4530. To exit 
back to the main menu, press <ESC>. 
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6.5 CURRENT SHIFT DATA (PROG PORT) 
 
The Current shift data menu displays the following information: 
 

 
 
This data is the totals so far into the current shift. This data is transferred to the “Last shift” data 
when the end of shift input transfers from a “0” to a “1”. This can be at the end of either an 8 or 12 
hour shift or alternatively could be done at label changes such that the data collected would be for 
label runs rather than complete shifts. This data cannot be reset either from this menu or by the 
operator, only at the end of shift input transition. To exit back to the main menu, press <ESC>. 
 
Total Good Cans Processed: This is the total number of good cans tested so far into the shift. 
This is essentially a can counter. 
 
Total Rejected Cans: This is the total number of rejected cans for all pockets of the machine. 
 
Pocket #01 rejects thru Pocket #12 rejects: This is the total rejected cans for each pocket. A 
disproportionately high count for a particular pocket indicates a sealing problem for that pocket. 
 
 
________________________________________________________________________________ 
6.6 LAST SHIFT DATA (PROG PORT) 
 
The “Last Shift” data is identical to the current shift data except it is for the previous 8 or 12 hour 
shift or previous label run, however the shift collection is set-up. This allows data collection and 
diagnostics to take place automatically over a two shift period. Refer to section 6.5 for definitions 
of the data fields in the “Last Shift” data menu. 
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6.7 DOWNLOAD PROGRAM TO M4530 (PROG PORT) 
 
This selection is used to download the HSLRT6 application program to the M4530 module. This 
should only be performed when replacing the M4530 module (see section 2.13) or when the 
program has been changed. To download the program, perform the following: 
 
Note: Program download cannot be performed while the tester is running. All outputs on the 
M4530 are turned “off” and no program execution is performed. Leak can detection would not take 
place such that if a bad can entered the machine, it would not be rejected. The tester should 
therefore be stopped while the download takes place (approximately 15 to 45 seconds depending on 
the computer used). 
 
1) Connect the RS-232 cable from the COM port on the computer to the “PROG” port on the 

M4530. 
 
2) Select “7: Download Program to M4530”. A prompt will be displayed asking to continue or 

abort. To continue, press any key except the <ESC> key. To abort, press the <ESC> key. If a 
prompt stating that the “HSLRT6.REV” file could not be opened is displayed, then the 
“HSLRT6” application program is not installed in the current directory. To install the program, 
perform the steps in section 2.11.4 to install the program. 

 
3) Once program download is initiated, M4530 program execution will cease, the current address 

being downloaded will be displayed, and the “RUN” LED on the M4530 will flash 
continuously. 

 
4) Once the download is complete, the “RUN” LED on the M4530 will illuminate solid and 

program execution in the M4530 will resume. Press any key to return back to the “HSLRT6” 
main menu. 
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This section provides information for fault situations (Calibrate error, offset error (MAINT), and an 
M4530 fault) as well as set-up or tuning problems (excessive cans rejected, calibrated leakers not 
rejected). With the exception of the M4530 fault, all trouble shooting is performed with “HSLRT6”. 
 
 
________________________________________________________________________________ 
7.1 GAIN CALIBRATE ERROR 
 
PROBLEM: 
“CAL” LED on M4530 “off” after calibration is performed and “CALIBRATION ERROR” 
message displayed on HSL-RT6-DSP. 
 
SOLUTION: 
Select the “M4530” Set-up” and verify the following: 
 
1) Verify that the “PMT Calibration Mode Enabled” is set to YES. If the PMT calibration mode is 

disabled, the M4530 cannot adjust the gain and sensitivity when the calibration procedure is 
performed, and this will result in the calibrate error. Enable the “PMT Calibration Mode” per 
section 5 (Windows setup program reference) or section 6 (DOS setup program reference) and 
perform the calibration procedure again. 

 
2) Verify that the “Desired Calibrated Leaker Reject PMT value” is at a reasonable value (40 to 

200). If this value is outside this range (say 0 or 255), the M4530 cannot adjust the gain to 
achieve calibration. Set the “Desired Calibrate Leaker Reject PMT value” between 40 and 200 
and try again.  

 
Note: The “Desired Calibrated Leaker Reject PMT value” must be greater than the “PMT 
Reject Can Threshold” (35 to 75), which in turn must be greater than the “Desired Good Can 
PMT Value” (20 to 30).  

 
Perform the calibration procedure again. If the problem persists, proceed to steps (3) and (4) 
below. 

 
3) If, after calibration, the “PMT Gain” is less than 500 volts and the “Gain Calibrate PMT Input 

Average” is greater than the “Desired Calibrated Leaker Reject PMT value”, the PMT detected 
too much light and was not able to reduce the gain of the PMT adequately to compensate for the 
amount of light detected. Verify that the calibrated leaker has a .0025 calibration hole in it and 
does not have any other areas of leakage in the can. Verify that the seal at the pocket used for 
calibration is not leaking. Verify that no light leakage is occurring at any of the PMT seals 
(machine shutter to light seal plate, PMT to light seal plate, or at the PMT housing itself). 
Perform the calibrate procedure (per section 3.4) and try again. Proceed to step (5) if the 
problem persists. 
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4) If, after calibration, the “PMT Gain” is at 1101 volts and the “Gain Calibrate PMT Input 
Average” is less than the “Desired Good Can PMT Value” by more than 5, then the PMT did 
not detect enough light and was not able to increase the gain enough to calibrate the M4530. 
Verify that the calibrated leaker has a .0025 calibration hole in it and also verify that the light 
source is generating an adequate supply of light (lamps “on” during calibration). If so, set the 
“Desired Calibrated Leaker Reject PMT Value” to a lower value (it can be set as low as 10 
above the “Desired Good Can PMT Value”) and try the calibration again. If the “Desired 
Calibrated Leaker Reject Value” is lowered, the “PMT Reject Can Threshold” should also be 
lowered (it should be between the “Desired Good Can PMT Value” and the “Desired Calibrated 
Leaker Reject Value”. Perform the calibrate procedure (per section 3.4) and try again. 

 
5) If the solutions in (3) and (4) above do not correct the problem, verify all cables between the 

M4530 and the PMT and try again. 
 
6) If the problem persists, verify that + and - 12VDC is present at the +12VDC, -12VDC, and 

AGND pins of the PMT of the M4530 and try again. 
 
7) If the problem persists, verify that +24VDC is being supplied to the PS2000N1 power supply 

and try again. 
 
8) If the problem persists, replace the 9956B-16 PMT tube and try again. 
 
9) If the problem persists, replace the PMT housing, A1H Preamp, GB1BH Gating circuit and try 

again. 
 
10) If the problem persists, replace the M4530 module. Set the module up per section 2.13 and try 

again. 
 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- 80 - 



SECTION 7 
TROUBLE-SHOOTING 

________________________________________________________________________________ 
7.2 OFFSET ERROR 
 
PROBLEM: 
“MAINT” Led on M4530 is “on”. 
 
SOLUTION: 
Select the “M4530” Set-up” and verify the following: 
 
1) If the “MAINT Alarm” entry in the Set-up menu displays either “Offset Exceeded +250” or 

“Offset Exceeded -250”, then the automatic offset routine attempted to adjust the offset outside 
the maximum + or - minus offset limits. If the offset exceeds + or -250 in an attempt to set the 
“PMT Input Average” equal to the “Desired Good Can PMT Value”, the MAINT LED on the 
M4530 will be illuminated. This indicates that the PMT is detecting an excessive amount of 
light both when the cans are sampled and at the in-between pocket measurement or that the 
offset potentiometer in the PMT B2F-RFI housing is set incorrectly. 

 
2) Verify that the “Desired Good Can PMT Value” is within a reasonable range (20 to 35). If this 

value is outside this range (say 0 or 255), the M4530 cannot adjust the offset enough to 
compensate for this unrealistic value. If the value was outside the range, set the “Desired Good 
Can PMT Value” between 20 and 35 and proceed to step (5).  

 
Note: The “Desired Calibrated Leaker Reject PMT value” must be greater than the “PMT 
Reject Can Threshold” (35 to 75) which in turn must be greater than the “Desired Good Can 
PMT Value” (20 to 30). 

 
3) Verify that the B2F-RFI PMT housing offset potentiometer is set correctly (see section 2.12.3). 
 
4) Verify that the machine is timed properly per section 2.12.2 and that no light leakage is 

occurring at any of the PMT seals (machine shutter to light seal plate, PMT to light seal plate, or 
at the PMT housing itself). 

 
5) Reset the “MAINT Alarm” by selecting “3: Reset MAINT alarm”. Run the machine with cans 

at normal line speeds and verify that the offset is automatically adjusted until the “PMT Input 
Average” is equal to the “Desired Good Can PMT Value” plus or minus 2. If the offset is again 
adjusted either up to the +250 max limit or down to the -250 max limit, perform step (6) below. 

 
6) Verify all cables between the M4530 and the PMT and try again. 
 
7) If the problem persists, verify that + and - 12VDC is present at the +12VDC, -12VDC, and 

AGND pins on the M4530 and try again. 
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8) If the problem persists, verify that +24VDC is being supplied to the PS2000N1 power supply 
and try again. 

 
9) If the problem persists, replace the 9956B-16 PMT tube and try again. 
 
10) If the problem persists, replace the PMT housing, A1H Preamp, GB1BH Gating circuit and try 

again. 
 
11) If the problem persists, replace the M4530 module. Set the module up per section 2.13 and try 

again. 
 
 
________________________________________________________________________________ 
7.3 M4530 FAULT 
 
PROBLEM: 
“FLT” LED on M4530 module “on”. M4530 none functional. 
 
SOLUTION: 
The “FLT” LED on the M4530 is illuminated when either the PMT Interface section of the M4530 
or the PLC section of the M4530 incurs an internal fault. Perform the following to read the M4530 
fault code: 
 
1) Connect computer to “PROG” port of M4530. 
 
2) Initiate “SYSdev” and select the “HSLRT6” program (or program which is normally 

downloaded to M4530). 
 
3) From the “Main Development Menu”, select “6: Target Board Interface”. 
 
4) From the Target Board Interface menu, select “4: Target Board Fault Codes/Status”. 
 
5) If the fault code displayed was “45H: User program system fault sfunc09 call”, the PMT 

Interface section incurred the fault. All other fault codes pertain to the PLC section of the 
M4530. 

 
6) Perform the corrective action described in the SYSdev fault menu and reset the fault code as 

prompted to by SYSdev. If the M4530 faults again, try cycling power to the M4530. If the 
M4530 faults again and will not run, replace the M4530, downloading the “HSLRT6” program 
(or other program if used) and perform the setup per section 2.13. 
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________________________________________________________________________________ 
7.4 EXCESSIVE GOOD CANS REJECTED 
 
PROBLEM: 
Excessive good cans rejected from machine. 
 
SOLUTION: 
Excessive good cans are rejected from the machine either when a particular pocket or pockets has a 
bad light seal or when the M4530 is setup too sensitive. Perform the following to trouble shoot: 
 
1) Select the “4: Number of Rejects per Pocket Data” selection from the “HSLRT6” main menu 

and observe the Per Pocket Reject Totals. If a particular pocket is rejecting a significantly 
higher number of cans than the other pockets, that pocket most likely has a bad light seal (or 
some other mechanical problem). Fix that pocket's seal and try again. If all pockets show high 
reject rates, continue to step (2). 

 
2) Verify that all pocket seals are in good condition with no visible leaks. Verify pocket air 

pressure. Verify that no light leakage is occurring at any of the PMT seals (machine shutter to 
light seal plate, PMT to light seal plate, or at the PMT housing itself). If these all look good, 
proceed to step (3). 

 
3) If the M4530 is setup too sensitive (“PMT Reject Can Threshold” too low, “Desired Calibrated 

Leaker Reject PMT Value” too high, or “PMT Gain” too high) excessive good cans will be 
rejected. Perform steps (4) through (7) to lower the sensitivity. 

 
4) Select the “M4530 Set-up” menu and set the “Desired Calibrated Leaker Reject PMT Value” to 

a lower value (between 40 and 200).  
 

Note: The “Desired Calibrated Leaker Reject PMT value” must be greater than the “PMT 
Reject Can Threshold” (35 to 75) which in turn must be greater than the “Desired Good Can 
PMT Value” (20 to 30).  

 
Perform the calibration procedure and try again. If a calibrate error occurs at this point, trouble 
shoot per section 7.1. 

 
5) If excessive cans are still being rejected, from the “M4530 Set-up” menu, increase the “PMT 

Reject Can Threshold” (normal range is 35 to 75).  
 

Note: If this is increased too high, calibrated leakers will not be rejected. Run calibrated leakers 
through the machine and verify they are still rejected. 

 
6) If excessive cans are still being rejected, select the “View M4530 PMT Data” menu and 

manually lower the “PMT Gain”. Again verify that the calibrated leakers are rejected at the 
lower gain settings. 
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7) If the problem persists, perform steps (5) through (10) of section 7.1. 
 
 
________________________________________________________________________________ 
7.5 CALIBRATED LEAKERS NOT REJECTED 
 
PROBLEM: 
Some or all of the calibrated leakers are not rejected when run through the machine. 
 
SOLUTION: 
In this case, either the sensitivity of the M4530 or PMT tube is too low. Other causes could be an 
inadequate light source (burned out tubes) or dirty shutter or starwheel. Perform the following: 
 
1) Verify that the light source is adequate and that there are no burned out bulbs. 
 
2) Verify that the machine is clean. The windows in the shutter must be free of dust and oil, and 

the plexi-glass starwheel should be clean. Verify that the PMT tube end window is also clean. 
 
3) If the machine is clean and the light source adequate, select the “M4530 Set-up” menu and 

lower the “PMT Reject Can Threshold” and try again. This value can be lowered to within 5 
above the “Desired Good Can PMT Value”. 

 
4) If the problem persists, increase the “PMT Gain” on the “View M4530 Data” menu and try 

again. This can be increased to a maximum of 1200 volts.  
 

Note: Running the “PMT Gain” above 1100 volts will shorten the life of the PMT. 
 
5) If the problem still persists, perform steps (5) through (10) of section 7.1. 
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The following are the recommended spares for the HSL-RT6-M45. All parts are available through 
Systems Engineering. 
 
 Quantity Part Number Description 
 
 1ea. M4530 PLC/PLS/PMT Module 
 1ea. P4500 Power Supply 
 1ea. S4568 8-IN/8-OUT 10-30VDC I/O BOARD 
 1ea. S4516 Communications board (if used) 
 1ea. S4573 16-Point 10-30VDC Output Board (if used) 
 1ea. D4591 Display/Keypad 
 
 1ea. RSV34-MS1 Resolver 
 
 1ea. PS2000N1 2K Volt PMT Power Supply 
 1ea. 9956B-16 Photo Multiplier Tube 
 1ea. B2F-RFI PMT Housing with C634 PMT Preamp and C641 PMT 

Gating Circuit 
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APPENDIX A 
MODBUS COMMUNICATIONS 

________________________________________________________________________________ 
MODBUS PORT CONFIGURATION 
 
The MODBUS driver uses the following data format and parameters (the MODBUS port on the 
MODICON PLC must be set to match these): 
 

MODBUS Port (PLC address):  5 
MODBUS Baud:  19.2K 
MODBUS framing mode:  RTU 
Number of start bits:  1 
Number of data bits:  8 
Number of stop bits:  1 
Parity:  NONE 

 
The MODBUS communications driver uses the S4516 communications board to both read and 
write data to a MODICON PLC. 
 
 
________________________________________________________________________________ 
DATA WRITTEN TO THE MODICON PLC 
 
The following data is written to the MODICON PLC: 
 
 MODICON Dest  M4530 Source 
 4x Address Data Definition Address 
 401700 Speed (CPM) W182 
 401701 Resolver Position W180 
 
Current Shift Data: 
 401702 Number of Good Cans (Lo-0 to 9,999) W1100 
 401703 Number of Good Cans (Hi-10,000's) W1102 
 401704 Total Rejects (Lo-0 to 9,999) W1104 
 401705 Total Rejects (Hi-10,000's) W1106 
 401706 Rejects Pocket #1 (current shift) W1108 
 thru  thru thru 
 401717 Rejects Pocket #12 (current shift) W1130 
 
Diagnostics Counts (resettable by the operator): 
 401718 Rejects Pocket #1 (diagnostic) W1050 
 thru  thru thru 
 401729 Rejects Pocket #12 (diagnostic) W1072 
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 MODICON Dest  M4530 Source 
 4x Address Data Definition Address 
 
PMT Set-Up/Status Variables: 
 401730 PMT Gain (in volts 498-to-1200) W1000 
 401731 PMT Offset Magnitude (0-to-250) B1002 
 401732 PMT Offset sign (0='+', 1='-') B1003 
 401733 Reject Threshold (0-to-255) B1004 
 401734 PMT Good Can Average Value B1005 
 401735 Status (to MODICON) W790 
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The bits of the Status register (to the MODICON from the M4530) are mapped as follows: 
 

W790: Status to MODICON (4x address 401735 in MODICON) 
B790.0: Bad Seal Pocket #1 

 thru thru 
B791.3: Bad Seal Pocket #12 
B791.4: Excess Good Can Rejection Alarm 
B791.5: PMT Calibration in Progress 
B791.6: PMT Calibration Error 
B791.7: Timing Signal Fail Alarm 

 
 
The Status bits sent to the MODICON PLC are defined as follows: 
 

B790.0: Bad Seal Pocket #1 
thru 

B791.3: Bad Seal Pocket #12 
The respective Bad Seal pocket alarm for pockets #1 thru #12 are activated when the 
corresponding pocket incurs over 4 rejects within 10 cans tested. 

 
B791.4: Excess Good Can Rejection Alarm - this bit is set to a “1” if 10 consecutive cans are 

rejected. The bit is cleared when 10 good consecutive cans are detected or when the 
machine stops. This generally indicates that a major compromise in the light seal 
(shutter plate to PMT gimbal or pocket seals) has occurred. In addition, this may also 
indicate an infeed track jam. This bit should be interlocked with the infeed low 
sensor to stop the machine if the infeed low sensor is covered and the bit is set to a 
“1”. 

 
B791.5: PMT Calibration in Progress - this bit is set to a “1” when the PMT Gain calibration 

is in progress. When this bit goes back to a “0”, bit6 of this byte should be tested to 
see if a calibration error occurred or not (see below). 

 
B791.6: PMT Calibration Error - this bit is set to a “1” if a calibration error occurred when 

the PMT Gain calibration is performed. If this bit is a “0” after the calibration is 
complete (bit5 above back “off”), then the calibration was successful. If it is “1”, a 
calibration error occurred. 

 
B791.7: Timing Signal Fail Alarm - this bit is set to a “1” if either CH00 or CH01 fails to 

change state once the tester is running (drive on for a time delay). 
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________________________________________________________________________________ 
DATA READ FROM THE MODICON PLC 
 
The following data is read from the MODICON PLC: 
 
 MODICON Dest  M4530 Source 
 4x Address Data Definition Address 
 401760 Status/Control (from MODICON) W792 
 
 
The bits of the Status/Control register (from the MODICON to M4530) are mapped as follows: 
 
Note: For all the following control bits, the corresponding action performed by the bit is activated 
at the leading edge (“off”-to-”on”) transition of the bit. Once a bit is set “on”, it must be set back to 
“off” some time latter, as if activated by a momentary PB contact. 
 

W792: Status/Control from MODICON (4x address 401760 in MODICON) 
B792.0: End of Shift 
B792.1: Reset Rejects per pocket (diagnostics W1050-W1072) 
B792.2: PMT Gain Calibrate Initiate 
B792.3: PMT Gain Increase (by 5 volts) 
B792.4: PMT Gain Decrease (by 5 volts) 
B792.5: Reject Threshold Increase (by one) 
B792.6: Reject Threshold Decrease (by one) 
B792.7: Alarm Reset 
B793.0: Set Resolver Zero (Auto Zero) 
B793.1: Not Used 
    thru 
B793.7: Not Used 
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The Status/Control bits sent from the MODICON PLC are defined as follows: 
 

B792.0: End of Shift - Setting this bit to a “1” transfers the current shift data in the M4530 to 
the last shift data and clears the current shift data (to start data collection for the next 
shift). The current shift data in the MODICON should be saved to the last shift data 
stack prior to setting this bit. 

 
B792.1: Reset Rejects per pocket - Setting this bit to a “1” clears the rejects per pocket 

diagnostics data in M4530 words W1050-W1072 (MODICON words 401718-
401729). This is usually done by the operator through out the shift to verify that one 
pocket is not rejecting at a higher rate than the other pockets. 

 
B792.2: PMT Gain Calibrate Initiate - Setting this initiates the gain calibration procedure just 

the same as the “CALIBRATE” button inside the panel does. The machine should be 
stopped with the calibrated leaker in front of the PMT prior to performing this. 

 
B792.3: PMT Gain Increase - Setting this bit to a “1” increases the gain of the PMT by 5 

volts. This is used to manually increase the gain. 
 
B792.4: PMT Gain Decrease - Setting this bit to a “1” decreases the gain of the PMT by 5 

volts. This is used to manually decrease the gain. 
 
B792.5: Reject Threshold Increase - Setting this bit to a “1” increases the “Reject Threshold” 

by one thus decreasing the system sensitivity. 
 
B792.6: Reject Threshold Decrease - Setting this bit to a “1” decreases the “Reject 

Threshold” by one thus increasing the system sensitivity. 
 
B792.7: Alarm Reset - Setting this bit to a “1” resets the bad pocket alarms for pockets 1-12 

and the timing signal fail alarm. 
 
B793.1: Set Resolver Zero (Auto Zero) - Setting this bit sets the PLS offset such that the 

current position is “0”. To set the resolver zero, stop the machine, align pocket #1 
precisely wit the PMT and then set this bit to a “1”. The Sync and Pocket #1 Marker 
timing are automatically set in the PLS section, no other action is required by the 
user to time the machine. 
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________________________________________________________________________________ 
HARDWARE 
 
DF1 communication takes place via the Channel 0 port of the Allen Bradley PLC. The RS-232 
cable should be constructed and connected as shown below: 
 
S4516-DF1 to PLC5 
 

 
 
Internally, the PLC-5 should be set up for RS-232C communication. Refer to the dip-switch settings 
guide on the side of the processor. 
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S4516-DF1 to SLC 
 

 
 
Additionally, the S4516-DF1 should be switched for RS-232 communication.   
 
Dip switch SW1 is the RS-232/RS-422 dip switch should be set to:  
 POLE 1 = ON  
 POLE 2 = OFF 
 
Dip switch SW2 is the slot address, and is dependent upon the rest of the cards in the M4530 rack.  
For the HSL-RT6 control system, SW2 should be set to: 
 POLE 1 = ON  
 POLE 2 = OFF 
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________________________________________________________________________________ 
SOFTWARE 
 
PLC5 
The following sample RSLogix5 code is used to execute the message control function to allow a 
PLC5 processor to communicate with the S4516-DF1 serial communications board. 
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SLC500 
The following sample RSLogix500 code is used to execute the message control function to allow a 
SLC500 processor to communicate with the S4516-DF1 serial communications board. 
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________________________________________________________________________________ 
USING THE MSG INSTRUCTION 
 
READ INSTRUCTION – PLC5 
The read message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The “Communication Command is PLC3 Word Range Read.  The Data Table Address can 
be any integer file address.  The 50 elements (total) read from the M4530 PLC are defined in the 
last section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if communications with the S4516-DF1 is 
executed over a Data Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – PLC5 
The write message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The “Communication Command is PLC3 Word Range Write.  The Data Table Address can 
be any integer file address.  The 10 elements written to the M4530 PLC are defined in the last 
section – Read/Write Data Definitions. 
 
 

 
HSL-RT6-M45 User’s Manual SYSTEMS Electronics Group 

 
- B6 - 



APPENDIX B 
DF1 COMMUNICATIONS 

READ INSTRUCTION – SLC500 
The read message (MSG) command for a SLC500 is setup as follows: 
 

 
 
 
Note:  The Data Table Address can be any integer file address.  The 50 elements (total) read from 
the M4530 PLC are defined in the last section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if communications with the S4516-DF1 is 
executed over a Data Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – SLC500 
The write message (MSG) command for a SLC500 is setup as follows: 
 

 
 
 
Note:  The Data Table Address can be any integer file address.  The 10 elements written to the 
M4530 PLC are defined in the last section – Read/Write Data Definitions. 
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________________________________________________________________________________ 
CHANNEL 0 SETUP 
 
PLC5 
The Channel 0 Serial Port should be setup as follows: 
 

 
 
Note:  The Communication Mode is setup for System (Point-to-Point). 
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The Channel 0 Options are setup as follows: 
 

 
 
The “Detect Duplicate Messages” should be unchecked. 
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SLC500 
The Channel 0 Serial Port should be setup as follows: 

 
 
The Channel 0 Options are setup as follows: 

 
 
The “Duplicate Packet Detect” should be unchecked. 
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________________________________________________________________________________ 
READ/WRITE DATA DEFINITIONS 
 
Data Read From The M4530 (50 Elements) Is Defined As Follows: 
 
 M4530 Mapped PLC  
Description Add Add Add Function 
General:     
M4530 Status Word 1 (to PLC)  W4600 N7:0 R/O 

Bad Seal Pocket #1 (Bit 00) B628.0 B4600.0 N7:0/0  
Bad Seal Pocket #2 (Bit 01) B628.1 B4600.1 N7:0/1  
Bad Seal Pocket #3 (Bit 02) B628.2 B4600.2 N7:0/2  
Bad Seal Pocket #4 (Bit 03) B628.3 B4600.3 N7:0/3  
Bad Seal Pocket #5 (Bit 04) B628.4 B4600.4 N7:0/4  
Bad Seal Pocket #6 (Bit 05) B628.5 B4600.5 N7:0/5  
Bad Seal Pocket #7 (Bit 06) B628.6 B4600.6 N7:0/6  
Bad Seal Pocket #8 (Bit 07) B628.7 B4600.7 N7:0/7  
Bad Seal Pocket #9 (Bit 08) B629.0 B4601.0 N7:0/8  

Bad Seal Pocket #10 (Bit 09) B629.1 B4601.1 N7:0/9  
Bad Seal Pocket #11 (Bit 10) B629.2 B4601.2 N7:0/10  
Bad Seal Pocket #12 (Bit 11) B629.3 B4601.3 N7:0/11  

Spare (Bit 12) B629.4 B4601.4 N7:0/12  
Spare (Bit 13) B629.5 B4601.5 N7:0/13  
Spare (Bit 14) B629.6 B4601.6 N7:0/14  
Spare (Bit 15) B629.7 B4601.7 N7:0/15  

     
M4530 Status Word 2 (to PLC)  W4602 N7:1 R/O 

Excessive Good Can Rejection (Bit 00) B121.4 B4602.0 N7:1/0  
PMT Calibration in Process (Bit 01) F34 B4602.1 N7:1/1  

PMT Calibration Error (Bit 02) F38 B4602.2 N7:1/2  
Timing Signal Fail (Bit 03) F18 B4602.3 N7:1/3  

Spare (Bit 04)  B4602.4 N7:1/4  
thru  thru thru  

Spare (Bit 15)  B4603.7 N7:1/15  
     
Machine Speed (CPM) W580 W4604 N7:2 R/O 
Resolver Position W180 W4606 N7:3 R/O 
     
Shift Data (Current Shift):     
Good Cans (Lo) W1100 W4608 N7:4 R/O 
Good Cans (Hi) W1102 W4610 N7:5 R/O 
Total Rejects (Lo) W1104 W4612 N7:6 R/O 
Total Rejects (Hi) W1106 W4614 N7:7 R/O 
Pocket #1 Rejects W1108 W4616 N7:8 R/O 
thru thru thru thru R/O 
Pocket #12 Rejects W1130 W4638 N7:19 R/O 
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 M4530 Mapped PLC  
Description Add Add Add Function 
Diagnostic Counts (resettable):     
Rejects - Pocket #1 W1050 W4640 N7:20 R/O 
thru thru thru thru R/O 
Rejects - Pocket #12 W1072 W4662 N7:31 R/O 
     
PMT Settings:     
PMT Gain (in volts) W1000 W4664 N7:32 R/O 
PMT Offset Magnitude (0 to 250) B1002 W4666 N7:33 R/O 
PMT Offset sign (0="+", 1="-") B1003 W4668 N7:34 R/O 
Reject Threshold (0 to 255) B1004 W4670 N7:35 R/O 
PMT Good Can Average Value B1005 W4672 N7:36 R/O 
     
Spare Registers:     
Spare  W4674 N7:37 R/O 
Spare  W4676 N7:38 R/O 
Spare  W4678 N7:39 R/O 
Spare  W4680 N7:40 R/O 
Spare  W4682 N7:41 R/O 
Spare  W4684 N7:42 R/O 
Spare  W4686 N7:43 R/O 
Spare  W4688 N7:44 R/O 
Spare  W4690 N7:45 R/O 
Spare  W4692 N7:46 R/O 
Spare  W4694 N7:47 R/O 
Spare  W4696 N7:48 R/O 
Spare  W4698 N7:49 R/O 
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Data Written To The M4530 (10 Elements) Is Defined As Follows: 
 
 M4530 Mapped PLC  
Description Add Add Add Function 
General:     
PLC Status Word 1 (from PLC) W792 W4700 N7:50 W/O 

End of Shift (1=Transfer Data) (Bit 00) B792.0 B4700.0 N7:50/0  
Reset Rejects Per Pocket (Bit 01) B792.1 B4700.1 N7:50/1  

PMT Gain Calibrate Initiate (Bit 02) B792.2 B4700.2 N7:50/2  
PMT Gain Increase (by 5 volts) (Bit 03) B792.3 B4700.3 N7:50/3  

PMT Gain Decrease (Bit 04) B792.4 B4700.4 N7:50/4  
Reject Threshold Increase (Bit 05) B792.5 B4700.5 N7:50/5  

Reject Threshold Decrease (Bit 06) B792.6 B4700.6 N7:50/6  
Alarm Reset (Bit 07) B792.7 B4700.7 N7:50/7  

Set Resolver Zero (Bit 08) B793.0 B4701.0 N7:50/8  
Spare (Bit 09) B793.1 B4701.1 N7:50/9  
Spare (Bit 10) B793.2 B4701.2 N7:50/10  
Spare (Bit 11) B793.3 B4701.3 N7:50/11  
Spare (Bit 12) B793.4 B4701.4 N7:50/12  
Spare (Bit 13) B793.5 B4701.5 N7:50/13  
Spare (Bit 14) B793.6 B4701.6 N7:50/14  
Spare (Bit 15) B793.7 B4701.7 N7:50/15  

     
PLC Status Word 2 (from PLC)  W4702 N7:51 W/O 

Spare (Bit 00)  B4702.0 N7:51/0  
Thru  thru thru  

Spare (Bit 15)  B4703.7 N7:51/15  
     
Spare  W4704 N7:52 W/O 
Spare  W4706 N7:53 W/O 
Spare  W4708 N7:54 W/O 
Spare  W4710 N7:55 W/O 
Spare  W4712 N7:56 W/O 
Spare  W4714 N7:57 W/O 
Spare  W4716 N7:58 W/O 
Spare  W4718 N7:59 W/O 
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